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1  ORGANIZATION OF THE HW4 MANUALS 
 
The HW4 manuals are organized in separate books so as to limit the size of the individual documents. A list 
of the HW4 manuals is provided in document E-M-HW4v3-DIR 
 
HW4 Manuals Contents 

HW4 Main Book 

General software description 
Installation, start-up and settings 
Device connection methods 
Functions common to all devices used with HW4 

Device Specific Functions 1 
(separate book for each device type or model) 

Legacy devices (original HygroClip technology): 
 
o HygroLog NT data logger 
o HygroFlex 2, HygroFlex 3 and M3 transmitters (same 

icon in device tree) 
o HygroLab 2 and HygroLab 3 bench indicators 
o HygroPalm 2 and HygroPalm 3 portable indicators 
o HygroClip DI digital interface 
o HygroClip Alarm programmable logic 
o HygroStat MB 
 
Device Manager (device configuration) and other device 
specific functions 

Probe Adjustment 1 Humidity and temperature adjustment function common to 
all legacy devices (original HygroClip technology) 

Device Specific Functions 2 
(separate book for each device type or model) 

Devices based on the AirChip 3000 technology such as: 
 
o HygroClip 2 (HC2) probes 
o HF3 transmitters and thermo-hygrostats 
o HF4 transmitters 
o HF5 transmitters 
o HF6 transmitters 
o HF7 transmitters 
o HF8 transmitters 
o HL20 and HL21 data loggers 
o HP21, HP22 and HP23 hand-held indicators 
o Custom designed OEM products 
 
Device Manager (device configuration, AirChip 3000 
functions) 

Probe Adjustment 2 Humidity and temperature adjustment function common to 
all devices based on the AirChip 3000 technology 

Data Recording Function Data recording function common to all devices based on the 
AirChip 3000 technology 

 
Both the HW4 manuals (software) and device specific manuals (hardware) are available on the HW4 CD. 
The manuals can also be downloaded from several of the ROTRONIC web sites. 
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2  OVERVIEW 
The HW4 software was developed by ROTRONIC AG for use with the ROTRONIC line of digital instruments 
and devices. HW4 is available in the following versions: 

2.1   HW4 Standard Edition 
o Unlimited number of instruments (depends on capabilities of PC and available ports) 
o On-line display of the measured and calculated values (dew point or other), limited to one instrument at a 

time. 
o Automatic retention of the most recent data in a temporary on-line buffer (multiple instruments). 
o Logging of measured and calculated values to the PC (multiple instruments). 
o Easy-to-read graphs and data tables. 
o Statistical data tools: mean, standard deviation, minimum and maximum of the recorded data   (off line 

only). 
o Data print-out (table or graph) 
o Automatic device/instrument recognition and identification 
o Device/instrument configuration 
o Access to the data recorded by a data logger and data transfer to the PC 
o Adjustment (calibration) of the HygroClip digital probes 
o Psychrometric Conversion Tool 
o Built-in security to protect against data manipulation 

2.2   HW4 Professional Edition 
HW4 Professional edition complies with ERES regulations. This version of HW4 allows multiple users, with 
either administrator or standard rights and password protection. 
 
o All the functionality of HW4 Standard Edition 
o RS-485 multi-dropped sub-networks of up to 64 instruments per sub-network 
o On-line display of the data from multiple instruments and probes 
o Possibility to overlay and synchronize data from several log files into a single graph 
o User Event Logging: automatically records user main operations. 
o Multiple users distributed into two groups: administrator and standard, each with different rights 
o Self Event Logging: automatically records any software problem to facilitate troubleshooting 
o Logger Event Logging: automatically records the data logger internal events and configuration changes. 
o Automatic creation of protocols detailing instrument configuration and programming changes as well as 

and probe adjustments. 
o Optical or acoustical indication of an alarm condition, tracking of alarm conditions in a table, and 

possibility of printing a report, sending an e-mail, etc. 
o Visual Indication an alarm conditions when viewing log file data  
o Password protected log-in 
o Meets the requirements of FDA 21CFR Part II for electronic records and electronic signatures 
o Meets the EU GMP requirements regarding pharmaceuticals. 
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2.3   HW4 Lite 
HW4 Lite is a special version of HW4 Professional which includes all features of HW4 Professional while 
being restricted to devices of the HygroWin type. 

2.4   HW4 Professional with OPC Server 
HW4 Professional with OPC server is a special version of HW4 Professional which includes all features of 
HW4 Professional while also providing OPC tags that can be enabled for each individual device 
communicating with HW4. This allows transferring data with practically any OPC client (requires 
configuration / programming of the OPC client by the user). 

2.5   HW4 Professional with AwQuick 
HW4 Professional with AwQuick is a special version of HW4 Professional designed to facilitate 
measurement of the water activity (Aw) of foods, pharmaceuticals, etc. This version includes all the features 
of the regular HW4 Professional Edition. Two modes are available for measuring water activity: AwE and 
AwQuick. Both modes can be used with any of our instruments. In the AwE mode, HW4 monitors the natural 
equilibration of the product being measured and automatically stops the measurement process when 
equilibrium is reached. With most products, natural equilibrium requires from 45 to 90 minutes. The AwQuick 
mode reduces the time required to measure water activity to a few minutes, usually with almost the same 
accuracy as the AwE mode. 

2.6   HW4 Professional Trial Version 
HW4 Trial is a fully functional version of HW4 Professional, including the OPC server and water activity 
measurement functionality. A compressed installation file (zip) can be downloaded free of charge from the 
ROTRONIC website at: 
 
http://www.rotronic-humidity.com/software/humidity_software_download.php 
 
Note: this web page is subject to change 
 
Activation requires an HW4 product key which can be requested by filling a form on the ROTRONIC web 
site. A trial product key will be sent to your e-mail address. This must be entered in the registration form 
which appears when starting HW4 for the first time. After 30 days, the trial product key expires and HW4 can 
no longer be started. 

2.7   HW4 Validated 
HW4 Validated offers the same functionality as HW4 Professional with OPC server. Additionally, the “HW4 
e-compliance Package” is available. This extensive collection of documents (including template of 
qualification documents) is designed to support the “regulated user” by qualifying/validating HW4-based 
solutions. 
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3  NEW IN VERSION 3.0.0 
HW4 version 3.0.0 includes all the functions and features of HW4 version 2.3.0 (last validated version) and 
2.4.0 with the following modifications and additions: 
 
● Devices compatible with HW4 
 
HW4 version 3.0.0 supports all devices supported by the latest release of HW4 version 2 and adds the 
support for the following devices: 
 

o HF8 transmitter with firmware version 2 
o HP23 and HP23-AW indicators with firmware version 2 

 
 
● Right pane in Group View mode 
 
Note: device groups are available only with HW4 Professional edition.  
 
The right pane is in the Group View mode whenever a group of devices is selected in the device tree (left 
pane). 
 
In addition to the Current Values tab (table of measured and calculated values for all the devices within the 
group), HW4 v 3.0.0 offers the following tabs: 
 

o Visual Layout Tab: this tab is used to superimpose the devices in a group over a background 
picture (room, machinery or other) so as to facilitate the visual monitoring of a process. Each 
device within the group is represented by a data label that can be freely positioned by the user. A 
data label displays the values measured or calculated by the corresponding device. Device alarms 
such as low battery, simulator mode, etc., are not shown. Within limits, the contents of a data label 
can be customized. In addition, the user can create and position descriptive test labels. 

o Probe Adjustment Tab: this tab allows the metrology laboratory to calibrate and adjust the probes 
attached to the devices within a group against a reference environment or against a reference 
probe. Any number of probes can be simultaneously selected. Due to differences in the process 
used for calibration and adjustment, probes based on the HygroClip 1 technology (legacy) cannot 
be selected at the same time as probes based on the HygroClip 2 technology.,  

o Log to PC Tab: this tab allows recording to a file on the HW4 PC the values measured or 
calculated by any probe attached to the devices within a group. Any number of probes can be 
simultaneously selected. 

 
 
● On-line graph in Group View mode 
 
Note: device groups are available only with HW4 Professional edition.  
 
One of the reasons for creating an instrument group is the ability to display a graph showing data from 
different instruments within the group. The data shown in the graph can be customized by selecting 
individual probes and parameters in the data table. HW4 v 3.0.0 remembers the selections made by the user 
for each group. 
 
● HW4 Users (HW4 Professional) 
 
In addition to allowing the deletion of a user, HW4 now allows de-activating a user. Unlike a deleted user, a 
de-activated user can be reinstated at any time. 
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● HW4 Professional Alarm Function 
 
Note: with all HW4 editions, any individual device reporting an alarm condition appears in red in the device 
tree. Device groups also appear in red when a member of the group reports an alarm condition. Values that 
are out of limits appear in red in the Current Values Tab, both in Device View and in Group View. Other 
types of alarms appear also as a red text in the Current Values Tab (low battery, simulator mode, etc.) 
 
The additional alarm functions available with HW4 Professional (alarm priorities. alarm records, alarm table, 
alarm schedule and alarm actions) have been completely re-worked to provide a much greater level of 
flexibility such as multiple alarm levels each with different actions. 
 
The HW4 Professional re-designed Alarm Function makes use of “Alarm Trigger Sets” that fall into two 
categories: the HW4 software Alarm Trigger Set (software or PC errors) and an unlimited number of Device 
Alarm Trigger Sets that can be created and defined by the user. 
 
Alarm Trigger Sets consist of one or several Trigger Events, each associated with a priority level, a time 
schedule and a set of actions. Except for the HW4 software Alarm Trigger Set, devices can be freely 
associated with any Alarm Trigger Set. 
 
HW4 offers a pre-defined list of Trigger Events such as communications error, low battery, etc. and also 
allows the user to define additional Trigger Events based on high and low limits for the measured or 
calculated values.  
 
● Adjustment of Individual HygroClip 2 probes and devices 
 
The adjustment function now includes the option of limiting the range of the humidity adjustment for a probe 
or device. For example, when all humidity calibration points are all smaller than 50%RH, it may make sense 
to limit the effect of the adjustment function to measurements below 50 %RH and to leave the original 
adjustment unchanged for measurement values above 50 %RH.  
 
● File name: Log to PC (all devices) and Auto-Download (HygroLog NT and HL-NT only) 
 
In order to make individual log files easier to identify, HW4 now provides additional flexibility regarding the 
name of the files that are automatically generated during Log to PC or Auto-Download operations. 
 
● HW4 View Data 
 
HW4 View data is the functional module that allows a user to view recorded data and to perform a number of 
operations with the log files. This module has been improved as follows: 
 

o View Data Window: HW4 now remembers both the size and position of the HW4 View Data 
window as determined by the user. The last configuration of the window is repeated each time that 
HW4 View Data is opened, until the user makes a change to the window. 

o Calculated parameter: HW4 now allows adding a calculated parameter such as the dew point to 
an existing log file consisting only of relative humidity and temperature records. This is useful in the 
case of probes and devices that cannot record a calculated parameter. In addition, it is also 
possible to change the calculated parameter recorded by or added to an existing log file. For 
example if a log file was recorded with the dew point as a calculated parameter, HW4 can change 
the calculated parameter to the frost point or other. The file can then be saved under the same 
name or under a different name. 

 
● OPC Tags  (HW4 Professional with OPC Server) 
 
The OPC Tags have been expanded to reflect the addition of new devices to our product line 
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4  HW4 REQUIREMENTS AND OTHER IMPORTANT 
INFORMATION 

4.1   Computer/Operating System Requirements 
The following are the minimum values required to install and run HW4 on a computer. It is highly 
recommended to exceed these values. 
 
o Processor: 1 GHz 
o RAM: 512 MB 
o Available hard disk space: 50 MB 
o Monitor: SVGA, 1280 x 960, 65535 colors 
o Ports: one free serial (COM) port or one free USB port or Network Interface Card / Ethernet LAN with 

one free port (RJ45 connector) 

4.2   Operating System Compatibility 

o Windows XP Service Pack 2, Vista, Windows 7 

4.3   Microsoft .NET framework 
 
HW4 was written for the Microsoft .NET framework (version 2.0) and requires this framework to be installed 
on the computer. 
 
The .NET framework offers significant improvements in the areas of networking and user security. When 
new software is being installed, the .NET framework also eliminates the potential problem of conflicting 
dynamic library files (DLL). According to Microsoft, the .NET framework will be used by all future Microsoft 
operating systems. 
 
Prior to installing HW4 you should verify that the Microsoft .NET framework (version 2.0) is installed on the 
PC. To do this, open Control Panel in Windows and select Add or Remove Programs. Windows displays an 
alphabetical list of installed programs. If Microsoft .NET framework is not listed it is not installed on the PC. 
Microsoft .NET framework v. 2.0 is included in the HW4 CD-ROM and can be installed as part of the HW4 
installation procedure. 

4.4   Location of the HW4 User Folder 
 
During the initial startup, HW4 automatically creates a user folder named ROTRONIC_HW4.  
HW4 also creates the folders DATA, DATA_ONLINE, SYS, DOC and EVENT within the ROTONIC_HW4 
folder. 
 
The ROTRONIC_HW4 folder holds the HW4 configuration files. The subfolders DATA, DATA_ONLINE, 
SYS, DOC and EVENT hold the log files (measurement data), protocols, event files and alarm records. 
 
Depending on the operating system, the location of this folder is as follows: 
 

o Windows XP: C:\Documents and Settings\Windows User\Application Data 
o Vista and Windows 7: C:\Users\Windows User\AppData\Roaming 

 
Windows User is the name that was used to log into the current Windows session. 
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Contents of the ROTRONIC_HW4 folder: 
 

 
 
 
By default, Windows User has exclusive access (permissions) to any folder or file that is located in 
C:\Documents and Settings\Windows User\Application Data (Windows XP) or in C:\Users\ Windows User 
\AppData\Roaming (Vista and Windows 7). For this reason, the default path for the HW4 user folder may not 
be always suitable for the intended use of HW4. 
 
For instructions about changing the path of the HW4 User Folder, see Relocating the HW4 User 
Folder BEFORE INSTALLING HW4. 
 

4.4.1 Running HW4 on a LAN with several workstations and a Windows 2003 file server 
The HW4 software is not designed to be installed on a Windows 2003 file server. When you wish to run 
HW4 on multiple workstations viewing and sharing the same data, you should proceed as follows: 
 

• Log in on one of the workstations as an administrator of the Windows 2003 server. 
• Install HW4 on the workstation following the procedure described under Installing HW4 
• After installing HW4 and prior to starting HW4, go to the HW4 installation directory on the workstation 

and change the path used by HW4 to locate the HW4 User Folder to the root directory of a file server 
drive that is mapped on each workstation (see Relocating the HW4 User Folder). 

• Start HW4 following the procedures described in this manual under Initial Startup 
• Close HW4 before installing HW4 on the next workstation 
• Repeat this procedure for each workstation 

 
Note: It is important to distinguish between a Windows user and a HW4 user. It is equally important to 
distinguish between the Windows permissions to a folder and HW4 rights. When the HW4 User Folder is 
located on the File server and is shared by all workstations, you should give all Windows users sufficient 
permissions to the HW4 User Folder and subfolders (Folder Properties - Security). 
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5  INSTALLATION 

5.1   Software Licensing Agreement 
 
1) Rights to software, know-how and process 
 
Without any specific agreement, the customer may make use of the available software HW4, the know-how, 
the data carriers and the documentation to the extent provided for, but must not pass it on to third parties.  
 
Any improvement, amendment or copying of the software by the customer requires permission in writing 
from ROTRONIC. The customer must include the same property rights notations on all modifications and 
copies as there are on the original.  
 
In all cases, ROTRONIC or its licensers retain the ownership of the software and the know-how and also 
retain the right to continued utilization, even if ROTRONIC supplies the source codes or if the customer 
subsequently makes amendments to the software programs or know-how recordings. 
 
2) Warranty against defects 
 
The customer's warranty rights presume that he or she has fulfilled his or her legal obligation to examine and 
make a complaint in respect of a defect immediately on receipt of the goods as is required.  
 
ROTRONIC shall be released from all obligations under all warranties either expressed or implied, if the 
software covered hereby is modified by persons other than its own authorized personnel, unless such 
modification by others is made with the written consent of ROTRONIC or unless such modification in the 
sole opinion of ROTRONIC is minor or unless such modification is merely the installation of a new 
ROTRONIC update or patch for the software. ROTRONIC makes no warranties which extend beyond the 
description of the software covered hereby other than as expressly stated herein, ROTRONIC expressly and 
specifically disclaims the implied warranty of merchantability and makes no warranty with respect to the 
fitness of the software covered hereby for any particular purpose or use unless such a warranty is expressly 
set forth. 
 
The buyer or anyone claiming under any warranty relating to the software sold hereunder agrees that if 
ROTRONIC breached any such warranty, or any warranty implied either in fact or by operation of law, or if 
the software warranted hereunder proves defective in any manner whatsoever, ROTRONIC sole liability 
hereunder is limited to either replacement of the defective software or at the option of ROTRONIC, refunding 
to the buyer the purchase price paid for such defective software. The buyer and anyone else claiming under 
any warranty relating to the software sold hereunder expressly and specifically agree that ROTRONIC is not 
responsible for, and the buyer or such other claimant or claimants shall assume, any liability for property 
damage, prospective profits, special, indirect, or consequential damage, or other commercial or economic 
loss arising out of use or possession of the software sold hereunder. ROTRONIC shall not be liable for, and 
a buyer or anyone else claiming under any warranty relating to the software sold hereunder further agrees, 
and shall assume, any liability for personal injury arising out of use or possession of the software sold 
hereunder. Representations and warranties made by any person, including dealers and representatives of 
ROTRONIC which are inconsistent or in conflict with the terms of this warranty (including but not limited to 
the limitations of the liability of ROTRONIC as set forth above), shall not be binding upon ROTRONIC unless 
given in writing and approved by an expressly authorized representative of ROTRONIC. 

5.2   Installing HW4 
Insert the HW4 CD-ROM into the CD drive or your PC. The installation program should start automatically. If 
the installation program does not start, use My Computer in Windows to open the CD drive and double click 
on the file start.exe located in the root directory of the CD. 
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IMPORTANT: HW4 requires a PC with the Microsoft .NET Framework version 2.0 or higher installed. If the 
Microsoft .NET Framework is not already installed on your PC, please click with the mouse on step 1 to 
install the framework. 
 
Note: save your work and close all open files because the computer will have to restart to complete the 
installation process. 
 
After installing the Microsoft .NET Framework, click on step 2 with the mouse to install HW4. Installation 
begins with the following form: 
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Click on the NEXT button: 
 

 
 
Click on the NEXT button to move through the different installation steps and follow the instructions provided 
on the screen. 
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The choice made above determines how the HW4 install program will make entries in the Windows registry 
(entries for all users or for the current user only). 
 
 
 

 
 
The default installation directory is C:\Program Files\HW4 and can be changed during installation. 
 
The shortcut HW4 is automatically created on the desktop during installation: 
 
Note: Upon starting HW4 for the first time, the folder ROTRONIC_HW4 will be automatically created in 
C:\Documents and Settings\Windows User\Application Data, where Windows User is the name that was 
used to log into the current Windows session. 
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When installation is complete, the following screen should appear: 
 

 
 
 
 
 
 
STOP HERE! 
 
Do not start using HW4 without reading the following: 
 
● Relocating the HW4 User Folder
 
● Preparing for device connection
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5.3   Updating HW4 to a newer version 
Prior to installing an update, you should first uninstall the old version of HW4. To do this properly, click on 
Start in Windows and open the Control Panel. Select Add or Remove Programs. ROTRONIC HW4 should 
be listed as one of the installed programs. Select ROTRONIC HW4 and click on the Remove button. 
 
Note: uninstalling HW4 from the Windows Control Panel does not delete the HW4 User Folder. 
ROTRONIC_HW4 
 
IMPORTANT: do not delete the HW4 User Folder (ROTRONIC_HW4) created by the old HW4 version. 
Deleting the HW4 User Folder will erase all users, all configuration and measurement data as well as all 
event tracking and protocols. It is advisable to make a temporary back-up copy of this folder. 
Unless otherwise mentioned, this folder can be used with the updated HW4. 
 
Depending on the operating system, the location of this folder is as follows: 
 

o Windows XP: C:\Documents and Settings\Windows User\Application Data 
o Vista and Windows 7: C:\Users\Windows User\AppData\Roaming 

 
Windows User is the name that was used to log into the Windows session the first time that HW4 was 
started. 

5.4   Uninstalling HW4 (full uninstall) 
 
IMPORTANT: Not following this procedure may result in problems later if HW4 is installed again. 
 
To properly uninstall HW4 and remove its main components, you should click on Start in Windows and open 
the Control Panel. Select Add or Remove Programs. ROTRONIC HW4 should be listed as one of the 
installed programs. Select ROTRONIC HW4 and click on the Remove button. 
 
To complete a full uninstall you should manually delete the HW4 User Folder (ROTRONIC_HW4).  
Depending on the operating system, the location of this folder is as follows: 
 

o Windows XP: C:\Documents and Settings\Windows User\Application Data 
o Vista and Windows 7: C:\Users\Windows User\AppData\Roaming 

 
Windows User is the name that was used to log into the Windows session the first time that HW4 was 
started. 
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6  CONNECTING DEVICES TO THE HW4 PC 

6.1   Definition: masters and slaves (HW4 Professional) 
HW4 Professional makes use of the following definitions: 
 
Master: any device, probe or docking station that is  
 

o connected either to a physical or to a virtual port of the PC either directly or by means of an 
interface adapter cable 

o directly connected to an Ethernet port (TCP/IP) either by cable or by wireless. 
 
Slave: any device or docking station that is connected to a master by means of an RS-485 multi-drop. 
Slaves cannot be used in conjunction with HW4 Standard Edition. 

6.2   Connection methods for master devices 
All versions of HW4 are compatible with the following methods for connecting devices to the HW4 PC: 
 
● Physical serial port 
● Bluetooth serial port (virtual COM port) 
● USB port  
● LAN (TCP/IP) - cable or wireless connection 
 

6.3   Connectivity hardware 
 
Please consult your probe or device hardware manual as well as document E-M-HC2-accessories (available 
from our website). 

6.4   Devices used as RS-485 slaves (HW4 Professional) 
HW4 Professional allows the use of one RS-485 multi-drop with each master device. Any RS-485 multi-drop 
is limited to a maximum of 64 devices (1 master and up to 63 slaves). Any device with a RS-485 port can be 
used either as a master or a slave, without special configuration. 
 
IMPORTANT: 
 
o RS-485 compatibility: the communications protocol used by the products based on the AirChip 3000 

technology is not compatible with the protocol used by the previous generation of ROTRONIC products 
as well as by the HygroLog HL-NT. Do not connect legacy products and AirChip 3000 products to the 
same RS-485 multi-drop network. HW4 is compatible with both AirChip 3000 products and legacy 
products as long as these products are connected to separate RS-485 multi-drop network. 
 
The AC3011 converter is an exception to the above rule and can be used to make a RS-485 network 
consisting both of legacy products and AirChip 3000 products (all devices must use the same Baud 
rate). 
 

o Baud rate: unlike legacy products, the 19200 Baud rate used by all products based on the AirChip 
3000 cannot be changed 
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Example: slaves connected to an Ethernet master 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RS485: 2 wires 

PC (HW4) 

Network 
Interface 

Card 
RS Addr. 1 RS Addr. 1 

RS485 RS485 
IP Addr.1 

RS Addr. 1 

RS485 
IP Addr. 2 IP Addr. n 

LAN (TCP/IP) 

RS-485 multi-drop: up to 1000m (3300 ft)

Note: each device directly connected to the LAN 
should have a unique IP address and must meet the 
compatibility requirements of the LAN. 

RS Addr. 2 

RS485 

Slave 

RS Addr. 64 

RS485 

Slave 

RS-485 slaves: address and Baud rate requirementsSee . 
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7  PREPARING FOR DEVICE CONNECTION 
 
NOTE: 
 
o Both the HygroLog NT and HL-NT require a docking station to provide an interface with the PC. 

 
o If you want to run HW4 on multiple workstations connected to a Windows 2003 file server, use only 

devices connected by Ethernet (wired or wireless) because this is the only type of connection that can be 
shared by all workstations. Devices connected by RS-485 to an Ethernet device can also be shared. 

7.1   Physical serial port 
Connecting an instrument or device to a physical COM port of the HW4 PC does not require any 
preparation. Simply connect the device to any available serial (COM) port on the PC.  

7.2   Bluetooth virtual serial port 
Note: This connection method is available only with some HygroLog NT models. Check the local menu of 
the HygroLog NT - Settings, and make sure that Bluetooth is on. 
 
Communication via Bluetooth requires the HW4 PC to be equipped with an internal or external Bluetooth 
transceiver. Connect your Bluetooth transceiver to the HW4 PC and install the driver supplied with the 
transceiver as per the instructions of the transceiver manufacturer.  
 
Typically, the Bluetooth driver has provisions for defining one or several Bluetooth serial ports (look for Local 
Services and / or Bluetooth Client Applications). Bluetooth serial ports are virtual COM ports and should be 
given a number that is distinct from the physical COM ports already present on the PC. Both the transceiver 
attached to the PC and the HygroLog NT should be given a unique COM port number. 
 
In addition, it is usually necessary to “pair” the transceiver with the Bluetooth enabled HygroLog NT. For 
security reasons, the process of “pairing” requires a password to be entered. By default, all ROTRONIC 
Bluetooth devices are identified as HygroBlue and use 1234 as the pairing password. 
 
In order to allow detection by HW4, any Bluetooth serial port must be manually declared in HW4 Global 
Settings – General Tab in the text box labeled Bluetooth serial ports, and then discovered manually using 
Search for RS-232 masters under Devices and Groups  in the HW4 main menu bar. 
 
HW4 detects and displays a Bluetooth device in the same manner as any device connected to the PC by 
way of a physical serial port. 

7.3   USB port  
Prior to connecting any ROTRONIC device to a USB port you should install the ROTRONIC USB driver on 
the HW4 PC. 
 
IMPORTANT: do not run HW4 while installing the USB driver on the PC. 
 
The ROTRONIC USB driver (ROTRONIC USB Option) can be installed before or after installing HW4. 
 
The following example shows how to install the driver with Windows XP. 
 
1. Prior to connecting the device to the PC, insert the HW4 CD-ROM in any available PC drive. The HW4 
installation screen starts automatically. Exit this screen. 
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2. Connect the instrument or docking station to any available USB port. Upon detecting the presence of a 
device connected to the USB port, Windows XP automatically starts the following wizard: 
 
If you are using Windows XP Professional SP2, the following screen appears. Select “No, not this time” and 
click on Next. This screen does not appear if you have not installed SP2. 
 

 
 
3. The following screen appears: 
 

 
 
Select “Install from a list or specific location” and click on Next. 
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4. Select “Search for the best driver in these locations”. Note that at this time the HW4 CD_ROM should 
have been already inserted in the PC. 
 

 
 
Click on Next 
 
5. You will receive the following warning. Disregard this warning and click on “Continue anyway”. 
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6. Windows copies the USB driver located on the HW4 CD-ROM and displays the following message when 
done: 
 

 
 
Click on “Finish” to complete the process. 
 
Note: If your device has only a serial port and the PC has a USB port but no COM port, you can install a 
USB Serial Adapter on one of the PC USB ports. In this situation, install the driver supplied with the USB 
serial adapter (not the driver supplied with HW4) and connect the device to this adapter. HW4 will assume 
that the device is connected to a serial (COM) port. 

7.4   Ethernet (TCP/IP) connection 
 
NOTES: 
 

• ROTRONIC devices with an Ethernet interface require configuration of the TCP/IP settings to ensure 
compatibility with the LAN to which the HW4 PC is connected (IP address, sub-net mask, gateway, 
etc.). Detailed instructions for configuring a ROTRONIC device with Ethernet (TCP/IP) interface are 
provided separately in document IN-E-TCPIP-Conf_11. A PDF version of this document can be 
downloaded from our web site. You may also want to read “Basic TCP/IP concepts” in this manual 
or consult with your network administrator prior to connecting any device to your local area network. 

 
• ROTRONIC devices with an Ethernet interface (both wired and wireless) are shipped with a Device 

Configuration Certificate that provides information about the factory configuration settings of both the 
Ethernet module and device. 
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Before configuring the device TCP/IP settings, you should make sure that the following is available to you: 
 
o An unused static IP address that is compatible with your network 
o The subnet mask of your network 
o The local IP address of the router used on the same LAN as the HW4 PC,  the default gateway used by 

all devices on the LAN 
 
In addition, the following information is required for a wireless connection: 
 
o The wireless network name (SSID) 
o The security mode (WAP, WEP or other) used by the HW4 network and the key or keys used by the 

security mode. 
 

7.4.1 Wired TCP/IP connection 
A device discovery utility (Digi Device Discovery) is provided in the HW4 installation directory (usually, 
C:\Program Files\HW4). The name of the corresponding file is dgdiscvr.exe. The Digi Device Discovery 
utility can be started by double clicking with the mouse on the file. 
 
Digi Device Discovery detects only products from Digi International such as the internal Ethernet module 
currently used by ROTRONIC for devices with an Ethernet interface.  
 
Connect the device to be configured to your LAN and double click with the mouse on dgdiscvr.exe to start 
Digi Device Discovery. 
 
When activated, Digi Device Discovery automatically detects any ROTRONIC device present on the LAN 
and provides a list of all such devices. 
  
The following example shows the initial screen for a device with TCP/IP settings that are not compatible with 
the LAN. Note the red warning that appears on the left side of the screen when the device is selected 
(highlighted).  
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With the device highlighted, click on “Configure network settings” to open the dialog box shown below. 
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When in doubt as to which setting to enter manually, select “automatically obtain network settings via 
DHCP” (requires a LAN with DHCP server such as a router). Using DHCP ensures that the device settings 
that are compatible with the LAN (subnet mask and default gateway) and that the IP address does not 
generate any conflict. 
 
Click on Save, Reboot the device and click on Refresh View. 
 
A dynamic IP address is subject to change whenever the device is powered down and then powered up. For 
this reason, you should now change the device configuration from dynamic IP address (DHCP) to static IP 
address. To do this, click again on “Configure network settings”. The current settings of the device (IP 
address, subnet mask, etc.) appear in light gray. 
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Click on “Manually configure network settings”. 
 

 
 
Change the device IP address to an address that is both currently unused on the LAN and outside of the 
range of dynamic IP addresses used by the DHCP server. To select a proper address, you may want to 
consult your network administrator. 
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7.4.2 Wireless TCP/IP connection 
The internal Digi module WI-ME used by wireless ROTRONIC devices does not allow a wired connection to 
a LAN and must be configured using a wireless connection. 
 
To allow a new wireless device to connect, the HW4 network wireless router has to be temporarily 
reconfigured and the wireless network security disabled. This is clearly not practical for most users and we 
recommend using a dedicated wireless router for the purpose of configuring a wireless ROTRONIC device. 
 
Detailed instructions for configuring a wireless Ethernet ROTRONIC device are provided separately in 
document IN-E-TCPIP-Conf_11. A PDF version of this document can be downloaded from our web site. 

7.5   RS-485 slaves: address and Baud rate requirements 
 
IMPORTANT: 
 
o RS-485 compatibility: The communications protocol used by the products based on the AirChip 3000 

technology is not compatible with the protocol used by the previous generation of ROTRONIC products. 
Do not connect legacy products and AirChip 3000 products to the same RS-485 multi-drop network. 
 
The AC3011 converter is an exception to the above rule and can be used to make a RS-485 network 
consisting  both of legacy products and AirChip 3000 products (all devices must use the same Baud 
rate). 
 

o Baud rate: the 19200 Baud rate used by all products based on the AirChip 3000 cannot be changed 
 
 
All devices that are compatible with HW4 have an internal RS-485 address ranging from 0 to 64. The factory 
default for the RS-485 address is 0. Similarly, devices are configured at the factory to use a specific Baud 
rate for all serial communications. In the case of devices with an internal Ethernet (TCP/IP) module, serial 
communication includes communication between the device proper and it internal Ethernet module.  
 
The RS-485 address is part of the communications protocol used by HW4 and is always included in the 
command sent to a device and in the device response. In the case of an RS-485 multi-drop, this address is 
used to identify each device and should be unique within the same multi-drop. 
 
Example: slaves connected to a COM or USB master 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RS232: 3 wires (including ground wire) 
RS485: 2 wires 

PC (HW4) 

COM Port 
or 

USB port 
Address 1 Address 2 Address 64

RS232 or 
USB 

RS485RS485RS485

up to 150m  (490 ft) 

Slave Slave 

RS-485 multi-drop: up to 1000m (3300 ft) 
HW4 Professional only 
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When searching for RS-485 slaves, HW4 automatically changes the factory default RS-address of both 
masters and slaves as explained below: 
 
o Masters: HW4 automatically changes the RS-485 address of any new device that is directly connected 

to the PC (master) from 0 to 1. As a result, all masters discovered by HW4 end up having the same RS-
485 network address (1). 

 
o Slaves connected to a master: in the situation where an RS-485 multi-drop is detected during a 

search, HW4 automatically changes the address of each slave with address 0 to a unique address 
ranging from 2 to 64. The same address range (2 to 64) is used again when there is more than one RS-
485 multi-drop. 

 
o Slaves connected via AC3010 or AC3011 converter: both the AC3010 and AC3011 converter allow 

connecting slaves without using a master device. The converter does not have a RS-485 address and 
does not count as a network device. During a search, HW4 automatically changes the address of each 
slave with address 0 to a unique address ranging from 1 to 64. The same address range (1 to 64) is 
used again when more than one converter is being used. 

 
 
IMPORTANT: 
 
o Avoid changing manually the factory default RS address (0) of new devices. Allow HW4 to change this 

address automatically. 
 

o Change manually the RS address to 0 in the following situations: 
 
- A master will now be used as a slave  
- A slave is being moved from one multi-drop to another. 
 
The change of address should be done prior to changing the physical connection (use HW4 Device 
Manager). If you forgot to do this, temporarily connect the device as a master to do the address change. 
 

o Duplicate RS addresses are not permitted within the same RS-485 multi-drop (with the exception of 
temporary address 0). Duplicate addresses may prevent communication with the devices or give 
unpredictable results. It is OK to use the same RS address in different multi-drops. 
 

o All devices within a multi-drop must use the same baud rate. Different Baud rates will prevent 
communication between the devices and the HW4 PC. 
 
Master with Ethernet (TCP/IP) interface: any change to Baud rate of the device done with HW4 Device 
Manager should also be reflected in the configuration of the internal Digi International module used by 
the device to connect to the LAN. 
See: Changing the baud rate of an Ethernet device 
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8  INITIAL START-UP 
Click on the HW4 shortcut created on your desktop by the installation program. 

8.1   Language selection 
The first form to open lists the different language files available within HW4: 
 

 
 
Use the mouse to highlight the desired language and click on Open. 
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8.2   Product key and registration 
The next form is the HW4 start-up form: 
 

 
 
 
First Time Users: HW4 requires you to register and you should now click with the mouse on the Registration 
link. This opens the following form: 
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Enter the HW4 product key, which is printed on a sticker affixed to the protective cover of the HW4 CD. Fill 
in the required information. If the box Register on-line is checked, clicking on Continue will connect you to 
the ROTRONIC web site, where your registration data will be automatically entered. If you do not have an 
internet connection or if you have already registered your copy of HW4, uncheck the Register on-line box 
and click on Continue. 
 
Registering on-line offers benefits such as free updates / patches and product information. 
 
Upon completing the registration, HW4 returns to the Start-up Screen. Depending on the HW4 product key 
entered in the previous form, the edition of HW4 that you are using is shown on the screen (in the example 
below: the validated edition of HW4 Professional). 
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To open the HW4 main screen, click with the mouse on the link labeled Start HW4. 
 
 

8.3   Device discovery after the initial start-up 
All devices connected to the HW4 PC must be searched manually. 
 
For instructions, see the following 
 
Preparing for device connection
 
Searching for devices with HW4
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When no devices has been discovered, or when no device is connected to the HW4 PC, HW4 creates a 
fictitious HygroLog HL-NT in the device tree (see “HW4 main screen overview”). This instrument is named 
“Offline” and should be deleted after manually discovering the actual devices connected to the PC. The red 
cross on top of the device icon indicates that there is no communication with the device. 
 

 
 

8.4   Creating the first user (HW4 Professional) 
If you are using HW4 Professional, you should create at least one user with administrator rights and a 
password in order to comply with ERES regulatory requirements. 
 

Users and passwordsSee: . 
 
Once the first user has been created, you will need to log in each time that you open HW4. 
 

 

8.5   Access to functions and screens (HW4 Professional) 
In all versions of HW4 Professional, access to most functions and screen views requires the current user to 
have sufficient rights. Whenever a function is not accessible or a screen view is not available, please verify 
that you have been granted the necessary rights. 
 
For an overview of user rights, including details for each individual right, please refer to the chapter Users 
and Passwords. 
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9  SEARCHING FOR DEVICES WITH HW4 
 
IMPORTANT: 
 
The following instructions assume that all necessary preparations have been made prior to connecting the 
different devices to the HW4 PC. See Preparing for device connection.  

9.1   Searching for master devices 
 
Depending on the connection method used for the master, use the following commands available in the 
HW4 main menu bar under Devices and Groups: 
  
o Physical COM (serial) port   : Search for RS-232 masters 
o Bluetooth virtual COM port   : Search for RS-232 masters 
o USB port     : Search for USB masters 
o Ethernet (TCP/IP) - cable or wireless connection : Search for Ethernet masters 

                                                                                 : Search for Specific IP Address 
 
Search for Ethernet masters: this command searches only for devices that are directly connected to the 
same local area network as the HW4 PC (both cable and wireless connection). The IP address of the 
device(s) does not have to be specified by the user. 
 
When the TCP/IP settings of a device are not compatible with the local area network, HW4 displays the 
following message box: 
 

 
 
Search for Specific IP Address: use this command to search for Ethernet devices that are connected to a 
different network (eventually via Internet). The IP address of the device must be specified by the user. 
 

9.2   Searching for RS-485 slaves (HW4 Professional) 
 
Use the Search for RS-485 slave devices commands located in the HW4 main menu bar under Devices 
and Groups. 
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10  HW4 MAIN SCREEN 
The HW4 main screen varies slightly depending on which edition of HW4 is running. The following 
description applies to the Professional edition which has more menu items and screens than the standard 
edition. 
 
The HW4 main screen is subdivided into a left pane and a right pane. The width of each pane can be 
adjusted with the mouse. The height of the two sub-panes located in the right pane (table and graph) can 
also be adjusted with the mouse. To change the size of a pane, go over the separation line with the mouse 
cursor. When the cursor changes, click and hold with the mouse. Drag the separation line where you want it 
to be. 

Left 
Pane 

Right 
Pane 
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10.1   Device Tree (left pane) 

10.1.1 Tree populated with individual devices 
All versions of HW4 display on the left pane of the screen a tree listing the devices that have been 
discovered by HW4. 
 

 
Each individual device is displayed in the left pane (for 
example: HP23, HygroLog NT, HF83, etc.). This is the default 
view for all versions of HW4 and the only view available with 
HW4 Standard edition 
 
Functions available for each device can be seen when the tree 
is expanded. These functions are specific of each type of 
device. 
 
To select a device or a function, click on it with the left mouse 
button. 
 
 
 
 
 
 

 
Right clicking with the mouse on a device opens the following menu: 
 

 
Most items present in this menu are 
described in chapter 10: HW4 Main Menu 
Bar, under Device and Groups and under 
View. 
 
The following menu items are present only 
in the case of a master device: 
 

o Search for RS-485 Slave Devices 
o Refresh the RS-485 Slave Devices 

 
Search adds to the device tree any device 
connected to the RS-485 interface of the 
master 
 
Refresh does not add nay new devices and 
is used to re-establish a lost connection with 
slave devices already present in the tree. 
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unctions. 

o select a group, a device or a function, click on it with the 

he left pane can also display one or several device groups 

 
ote: after being detected, devices appear individually in the tree regardless of the manner in which they are 

10.1.2 Tree populated with device group(s) - HW4 Professional 
A device group is a logical grouping of devices (as opposed to a physical grouping) created and defined by 
the user. Both masters and slaves can be part of a group, with no restriction other than not duplicating 
devices. Individual devices can be moved to any existing group or removed from the group (see “Devices 
and Groups”). 
 
In addition to facilitating network management within HW4, using device groups makes it possible to 
simultaneously display selected data from several individual devices within a group. The data can be viewed 
either as a table or as a live graph.  
 
By default HW4 displays a device group as opposed to displaying each individual device in the group. 
Individual devices can be displayed by expanding the group. 

 
HW4 Professional edition allows the creation of device 
groups. When one or more groups have been created 
(example Workshop, Office), and all devices have been 
moved to a group, the left pane displays a tree listing only 
groups. 
 
A group can be expanded to show the devices within the 
group and each device can be expanded to show its f
 
T
left mouse button. 
 
 
 

 
 
T
(Workshop) as well as individual devices that are not part of 
any group (HP23). 
 
 
 
 
 
 
 
 
 

 

N
connected to the PC (master or slave). 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 39 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

10.1.3 Instrument group: renaming and changing the contents 
The following menu can be opened by right clicking on a group: 

 
 
Rename Group: after creating a group, the group 
can be renamed in the same manner as a file can 
be renamed in Windows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

► Add a device to a group: 
 
After creating a group, individual devices can be moved to the group. Click on the device with the mouse 
and hold. A small rectangle appears next to the device. Drag the small rectangle on top of the group.  
Release the mouse when the name of the group is highlighted. Instruments within a group are displayed in 
the reverse order in which they were added to the group. 
 
  
► Remove a device from a group: 
 
Expand the group to display all devices within the group. Click on the device with the mouse and hold. A 
small rectangle appears next to the device. Drag the small rectangle to the bottom of the device tree, clear 
of any group and release the mouse. 
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10.2   Right pane in Device View mode 
The right pane is in the Device View mode whenever an individual device is selected in the device tree (left 
pane). 
 
In the Device View mode, the right pane is as illustrated below. To select any of the available tabs, click on 
the corresponding label with the mouse left button. 
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10.2.1 Current Values tab 
With this tab selected, the top of the right pane displays a table of the most recent values for the device 
currently selected in the device tree. The values are continuously updated according to the device polling 
interval set in HW4 Global Settings > General tab. 
 
The table shows data from the different probe inputs of the device, as well as other information. Click and 
drag a column header with the mouse to change in which order fields are being displayed. 
 

 
 
The table displayed in the Current Values tab can be customized.  

10.2.1.1 Customizing the Current Values tab 
 
► Data columns in the Current Values tab 
 
Depending both on the type of device and on the configuration of the device, HW4 can display a number of 
data elements in the Current Values tab. Different types of data appear in different columns of the Current 
Values table as explained below: 
 

Data Column Headers Notes 

Humidity 
Value 1 Humidity digital HygroClip probe digital output 

HygroClip probe analog output 
(channel 1) Humidity analog Value 1 

Temperature 
Value 2 Temperature digital HygroClip probe digital output 

Our instruments accept only single channel 
analog probes (channel 1 = humidity) Temperature analog N/A 

Calculation Calculation Dew point, humidity ratio, etc. 

Analog Input 
Value 1 Analog probe (single channel) 3d party analog probe 

Analog Input 
Value 1 Pressure probe 3d party analog pressure probe 

Requires an instrument that can be configured 
to perform a user defined calculation such as 
the difference between two temperatures. 

Custom Calc. 
Value 1 Custom Calculation 

L-Input 1 
Value 1 

Logical input used to monitor an external 
contact (1 = closed / 0 = open) Logical input 1 

L-Input 2 
Value 2 

Logical input used to monitor an external 
contact (1 = closed / 0 = open) Logical input 2 
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Data Column Headers Notes 

Relays 
Value 1 

Status of relay outputs 1 to 4 
(1 = energized / 0 = de-energized) Relay 1 to Relay 4 

 
Note: the columns “Value 1” and “Value 2” are provided for users who wish to minimize the number of 
columns in the data table. 
 
► Column selection in the Current Values tab 
 
To make HW4 display only specific data columns in the Current Values tab, select any individual device 
present in the device tree (for example HyGen Lab 2 in the left pane). In the HW4 main menu bar, click on 
Settings and Tools and on Column Headers. 
 

 
 
 
HW4 opens the following form. Make your selection using the mouse. The selection applies globally to all 
devices displayed in the Current Values tab. 
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► Order of the columns in the Current Values tab 
 
The order of the columns in the Current Values tab can be changed. To move a column to the right or to the 
left, left click with the mouse on the column header and drag it to its new position. 
 
► Row selection in the Current Values tab 
 
Select a device present in the device tree and use View & Alarm Settings Tab to select the rows to be 
displayed in the Current Values tab. The row selection applies only to the device currently selected in the 
device tree. 
 

 
 
 
 
NOTES: 
 
o The selections made in the View Tab affect the Current Values Tab in the Group View mode. 
 
o The selections made in the View Tab also affect the following tabs and forms: On-line buffer tab, Log to 

PC tab, Device Manager form, Data Logging form and Probe Adjustment form. 
 
If you do not see an input, a contact, etc. in any of these tabs and forms, remember to check the 
selections made in the View Tab. 
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10.2.2 Online graph 
By default, the bottom of the right pane displays data in graphic form. The graph is constantly updated 
according to the time interval selected in HW4 Global Settings > General tab for the online buffer. 
Depending on the selection made in HW4 Global Settings > Graph Settings tab > Automatic scaling, the 
scale of the graph is automatically selected by HW4 or can be changed manually on the graph. 

 
The following selections can be made with the mouse: 
 
    ● To display all the parameters associated with a probe, left 
click on the desired probe number in the table located above the 
graph. 
 
    ● To display only one probe parameter at a time, left click on 
the desired parameter in the table. 
 
    ● To display only one parameter for all probes, left click on the 
header of the parameter. 
 
If so desired, the graph can be hidden so as to provide more room 
for the probe data table (see HW4 Global Settings - View Tab). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The appearance of the graph can be customized. For details see “Settings and Tools - HW4 Global 
Settings – Graph Settings tab”. 
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To adjust the height of the data table and the height of the graph, bring the mouse cursor over the horizontal 
edge separating the graph and the table. When the mouse cursor changes, left click, hold and drag to the 
desired location. 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

10.2.3 Online Buffer tab 
With this tab selected, the right pane displays a table that shows the most recent historical data (limited to 
humidity, temperature and the calculated parameter). The time interval used to capture data to the on-line 
buffer is the value specified in HW4 Global Settings > General tab. This tab is also used to specify the 
maximum number of lines in the buffer. When the table is full, the oldest data are dumped from the bottom of 
the table as the most recent data is added to the top of the table. 
 
The probe input to be displayed is selected from the text box located on top of the data table (left click on the 
arrow to the right of the box to display a list of the inputs that can be viewed – this list depends on the 
selections made in the View tab). The on-line graph is based on the contents of the on-line buffer. 
 

 
 
► The contents of the on-line buffer are lost upon exiting HW4. 

Click on this button to show or hide the Data Cursor on the 
graph. The Data Cursor displays numerical data from the 
graph. Move the mouse cursor to any location in the graph. 
Click to make the Data Cursor jump to that location. Bring the 
mouse cursor to the left or to the right of the graph. The Data 
Cursor moves with each mouse click. 

Select a specific probe input and a parameter such as 
humidity. Click on this button to show or hide an alarm band 
on the graph corresponding to the programming of the probe 
input. 

Click on this button to erase the contents of both the online 
buffer and online graph 

To zoom in: left click with the 
mouse and hold to draw a 
rectangle in the graph. 
 
Click on the 1:1 button to 
restore the graph to its 
original scale. 
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10.2.4 Log to PC tab 
 
The Log to PC tab is used to record data directly on the PC from any type of instrument that is selected in 
the Device Tree.  All input types recognized by HW4 are listed in this tab, whether they exist or not on the 
actual device. When the list of inputs is either empty or incomplete, please go to the View & Alarm Settings 
Tab and check the selections (see Right Pane: Device View Mode). Only those items selected in the View 
Tab are visible in the Log to PC tab. 
 
► Top of the screen: 
 

 
 
► Bottom of the screen: 
 

 
 
► Procedure: 
 

o Select the device in the Device Tree (left pane) 
o Select the probe or probes to be recorded. Any number of probes can be simultaneously 

selected. To select a single probe, click on the corresponding line. To select several probes, press 
the CONTROL key and click on each corresponding line. 

o Select a log interval (common to all selected probes) 
o To limit the size of the individual log files you may choose to have HW4 automatically start a 

new file at regular intervals of time (see File Size below) 
o Select a path for the log files (click on the button to the right of the path field to display drives 

and folders) 
o Define a file name structure (3 fields are available for this) and select the file type. XLS 

denotes an editable text file that can be opened with MS Excel, Notepad or other. LOG denotes an 
encoded binary file that requires HW4 to be opened (HW4 Main Menu Bar > File > Open) 

o Click on the “Save” button 
o Click on the “Start Logging” button to start recording data 

 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 47 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

 
► File size (Start a New File) 
 
Click on the arrow to the right of the box labeled “Start a New File” to display a pull down menu of the 
available log modes: 
 
o Never    : log file of unlimited size (must be closed manually) 1 
o Each day   : start a new at 00:00 (midnight) each day. 
o Each week   : start a new file at 00:00 each Monday. 
o Each month  : start a new file at 00:00 on the first day of each month 
o Each year   : start a new file at 00:00 on the first day of each year 
 
1 As far as possible avoid using the unlimited size mode. With any of the other selections, HW4 
automatically starts a new file after closing the current file. 
 
 
A green symbol appears at the beginning of each line corresponding to a probe for which data is being 
recorded: 

 
► Automatic Log File Download (HygroLog NT / HL-NT only) 
 
HW4 Professional: when a HygroLog NT or HL-NT is selected in the device tree, the bottom part of the Log 
to PC tab can be used to enable the automatic downloading of log files to the PC: 
 

 
 
For instructions regarding this function see Automatic File Download in the following documents: 
 

o HygroLog NT : E-IN-HW4v3-F1-001 
o HygroLog HL-NT : E-IN-HW4v3-F2-013 
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10.2.5 View & Alarm Settings tab 
The View tab is used to select which items (inputs, custom calculation, and status of optional relays) are 
displayed by HW4 in the Current View, On-line buffer and Log to PC tabs. 
 
► Select here which items to show for this device: 
 

 
 
 
Use the mouse to select the items that correspond to your actual use of the various device inputs. 
 
IMPORTANT: the selections made in this tab also affect what can be seen in the following forms: Device 
Manager, Data Logging and Probe Adjustment. 
 
► Alarm Trigger Set: 
 
 

 
 
Click on the arrow to the right of the “combo-box” to view a list of the available “alarm trigger sets” and click 
on your selection. Click on the button labeled “Assign to Device” to assign the selected alarm trigger set to 
the device.  
 
Instructions for creating “Alarm Trigger Sets” are provided in this manual under: 
HW4 Global Settings > Alarm Settings
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10.2.6 OPC Server tab 
This tab is available only with HW4 Professional with OPC server. Unless your HW4 product enables this 
edition of HW4, you cannot use the OPC feature of HW4. With OPC server enabled, HW4 can communicate 
with any OPC client application to the purpose of bringing together data from HW4 and data from other 
sources. The OPC client application needs to be configured / programmed to read or write to the OPC tags 
provided by HW4. 
 

 
 
A full description of the HW4 OPC server is available in the following document, available from ROTRONIC: 
IN-E-OPC HW4-V3_10.pdf 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 50 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

 

10.2.7 AwQuick / AwE Mode tab 
This tab is available only with HW4 Professional with AwQuick. Unless your HW4 product key enables this 
edition of HW4, you cannot use the water activity functions of HW4. 
 
HW4 features two modes for measuring water activity:  
 
● AwE mode: 
 
In this mode HW4 monitors the stability of both temperature and humidity. The measurement is 
automatically ended as soon as both humidity and temperature reach equilibrium. The natural (or static) 
equilibration of most products typically requires from 45 to 60 minutes and can take as long as a couple of 
hours. 
 
The criteria used to determine that temperature and humidity have reached equilibrium can be modified by 
the user. 
 

 
 
● AwQuick mode: 
 
This mode accelerates the measurement of water activity and provides a result in typically 5 minutes. When 
temperature conditions are stable (both at the product and probe), the measurement obtained with the 
AwQuick mode is generally within ± 0.005 aw of the measurement that would be obtained by waiting for full 
equilibration. 
 

 
 
For instructions for using either mode, see Water Activity Measurement with HW4
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10.3   Right pane in Group View mode 
Note: device groups are available only HW4 Professional edition.  
 
The right pane is in the Group View mode whenever a group of devices is selected in the device tree (left 
pane). In the Group View mode, the right pane is as illustrated below. 
 

 
 

10.3.1 Current Values tab 
The top of the right pane displays a table of the most recent value for the different parameters associated 
with the devices in the group selected in the device tree. The values are continuously updated according to 
the device polling interval set in HW4 Global Settings > General tab. 

10.3.1.1 Customizing the Current Values tab 
 
► Data columns in the Current Values tab 
 
Depending both on the type of device and on the configuration of the device, HW4 can display a number of 
data elements in the Current Values tab. Different types of data appear in different columns of the Current 
Values table as explained below: 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 52 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

 
 
 

Data Column Headers Notes 

Humidity 
Value 1 Humidity digital HygroClip probe digital output 

HygroClip probe analog output 
(channel 1) Humidity analog Value 1 

Temperature 
Value 2 Temperature digital HygroClip probe digital output 

Our instruments accept only single channel 
analog probes (channel 1 = humidity) Temperature analog N/A 

Calculation Calculation Dew point, humidity ratio, etc. 

Analog Input 
Value 1 Analog probe (single channel) 3d party analog probe 

Analog Input 
Value 1 Pressure probe 3d party analog pressure probe 

Requires an instrument that can be configured 
to perform a user defined calculation such as 
the difference between two temperatures. 

Custom Calc. 
Value 1 Custom Calculation 

L-Input 1 
Value 1 

Logical input used to monitor an external 
contact (1 = closed / 0 = open) Logical input 1 

L-Input 2 
Value 2 

Logical input used to monitor an external 
contact (1 = closed / 0 = open) Logical input 2 

Relays 
Value 1 

Status of relay outputs 1 to 4 
(1 = energized / 0 = de-energized) Relay 1 to Relay 4 

 
Note: the columns “Value 1” and “Value 2” are provided for users who wish to minimize the number of 
columns in the data table. 
 
► Column selection in the Current Values tab 
 
To make HW4 display only specific columns in the Current Values tab, select a device group that is present 
in the device tree (for example RIC LAN in the left pane). In the HW4 main menu bar, click on Settings and 
Tools and on Column Headers. 
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HW4 opens the following form. Make your selection using the mouse. The selection applies globally to all 
groups displayed in the Current Values tab. 
 

 
 
► Order of the columns in the Current Values tab 
 
The order of the columns in the Current Values tab can be changed. To move a column to the right or to the 
left, left click with the mouse on the column header and drag it to its new position. 
 
► Row selection in the Current Values tab 
 
The rows displayed in the current values table depend on the selections made for each individual device. 
See “Right pane in Device View mode - View Tab”. 
 

10.3.2 On-line graph 
One of the reasons for creating an instrument group is the ability to display a graph showing data from 
different instruments within the group. For example, to display relative humidity for all instruments and 
probes within a group, click on the Humidity header in the data table. To select other data for the graph, 
press the CONTROL key and click on any desired parameter(s) in the data table. 
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The graph is constantly updated according to the time interval selected in HW4 Global Settings > General 
tab for the online buffer. Depending on the selection made in HW4 Global Settings > Graph Settings tab > 
Automatic scaling, the scale of the graph is automatically selected by HW4 or can be changed manually on 
the graph. 
  
The appearance of the graph can be customized. For details see “Settings and Tools - HW4 Global 
Settings – Graph Settings tab”. 
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10.3.3 Visual Layout tab 
 

 
 
This tab is used to superimpose the devices in a group over a background picture (room, machinery or 
other) so as to facilitate the visual monitoring of a process. Each device within the group is represented by a 
data label that can be freely positioned by the user. A data label displays the values measured or calculated 
by the corresponding device. Device alarms such as low battery, simulator mode, etc., are not shown.  
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Right clicking on the background picture opens a small menu that can be used to load a different picture and 
/or to add a descriptive text label that can be position anywhere over the background.  
 

 
 
Right clicking on a data label opens a small menu. The contents of this menu depend on the type of the 
device associated with the data label. 
 

 
 
To prevent a data or text label from being moved around, select “Fixed Position” 
 
Label Settings allows customizing the contents of a label: 
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10.3.4 Probe Adjustment tab 
 
This tab allows the metrology laboratory to calibrate and adjust the probes within a group against a 
reference environment or against a reference probe. Any number of probes can be simultaneously selected.   
 

 
 
 
IMPORTANT: 
 

o Depending on the temperature unit selected in HW4 Global Settings > Language/Unit System 
tab, calibration reference values such as temperature, dew point or frost point are  entered either in 
°C or in °F. 
 

o Close and restart HW4 after changing the temperature unit in HW4 Global settings. 
 

o Do not include in the selection any probe or device that does not use the same temperature 
unit as HW4 
 

o When a probe is connected to another device (HF5 transmitter, HP23 indicator, etc.), make 
sure that the probe and device are both set to the same temperature unit. This can be verified by 
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opening the Device Manager of the probe and the Device Manager of the transmitter or indicator. 
 

o Do not capture temperature calibration points that are that are a mix of °C and °F 
 

o Due to differences in both the calibration and adjustment process, probes based on the 
HygroClip 1 technology (legacy) cannot be selected at the same time as probes based on the 
HygroClip 2 technology 
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The contents of the screen bottom depend on the type of probe that is selected: 
 
► HygroClip 2 probe and other AirChip 3000 devices 
 

 
 
► HygroClip 1 probe and other legacy devices 
 

 
 
● Reference Type: HW4 allows calibrating either against a known reference environment (Manual Entry) or 

against any probe (reference probe) that is already part of the group. 
 
In the case of a humidity calibration, the reference environment can be defined as a %RH value, a dew 
point value or a frost point value. When using a dew point or a frost point value be sure that the 
temperature measured by the probe is as accurate as possible since the temperature value will be used 
by HW4 to convert the dew or frost point into a relative humidity value. The %RH [RHS] option is meant to 
be used with the Rotronic humidity standards. Enter the nominal value of the standard as per the 
certificate provided with the standard. The effect of temperature on the standard is automatically 
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compensated by HW4.  
 

● Reference Value: when calibrating against a reference environment (Manual Entry), use this field to 
specify the humidity or temperature value of the environment When calibrating against reference probe, 
HW4 automatically enters in this field the humidity or temperature value measured by the reference probe. 

 
► HygroClip 2 Procedures: 
 

1) After selecting the probes, click on the button labeled “Information”. HW4 reads the probe and 
writes information in the table regarding the calibration points already present in the probe or 
device memory 

2) After entering the value of the reference environment or selecting the reference probe, click 
on the button labeled “Capture Cal. Point” to capture the calibration point to the probe or device 
memory. 

3) To adjust the probe or device based on the calibration points present in the probe or device 
memory, click on the button labeled “Adjust” 

 
For additional information see document E-M-HW4v3-A2-001 
 
 
► HygroClip 1 (legacy) Procedures: 
 

1) After selecting the probes, click on the button labeled “Information”. HW4 verifies that it is 
communicating with the probe and writes OK in the table 

2) After entering the value of the reference environment or selecting the reference probe, click 
on either the “1-Point Adjustment” button or on the “Multi-Point Adjustment” button. 

 
For additional information see document E-M-HW4v3-A1-001 
 
 
► General Limitations: 
 

o Access to the functions available in this tab is subject to the user having the required rights 
o Probes based on the HygroClip 1 technology (legacy) cannot be selected at the same time as 

probes based on the HygroClip 2 technology 
o When configured to do so (HW4 Global Settings > Events Tab > Generate and Save 

Protocols), HW4 generates a report that covers all selected probes as opposed to generating a 
separate report for each individual probe 

 

10.3.5 Log to PC tab 
This tab allows recording to the HW4 PC the values measured or calculated by any probe or device that are 
within a group. 
 
► Top of the screen: 
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► Bottom of the screen: 

 
 
► Procedure: 
 

o Select the probes or devices. . Any number of probes or devices can be simultaneously 
selected. To select any single probe or device, click on the corresponding line. To select several 
probes or devices, press the CONTROL key and click on each corresponding line. 

o Select a log interval (common to all selected probes and devices) 
o To limit the size of the individual log files you may choose to have HW4 automatically start a 

new file at regular intervals of time 
o Select a path for the log files (click on the button to the right of the path field to display drives 

and folders) 
o Define a file name structure (3 fields are available for this) and select the file type. XLS 

denotes an editable text file that can be opened with MS Excel, Notepad or other. LOG denotes an 
encoded binary file that requires HW4 to be opened (HW4 Main Menu Bar > File > Open) 

o Click on the “Save” button 
o Click on the “Start Logging” button to start recording data 

 
► File size (Start a New File) 
 
Click on the arrow to the right of the box labeled “Start a New File” to display a pull down menu of the 
available log modes: 
 
o Never    : log file of unlimited size (must be closed manually) 1 
o Each day   : start a new at 00:00 (midnight) each day. 
o Each week   : start a new file at 00:00 each Monday. 
o Each month  : start a new file at 00:00 on the first day of each month 
o Each year   : start a new file at 00:00 on the first day of each year 
 
1 As far as possible avoid using the unlimited size mode. With any of the other selections, HW4 
automatically starts a new file after closing the current file. 
 
A green symbol appears at the beginning of each line corresponding to a probe or device for which data is 
being recorded: 
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11  HW4 MAIN MENU BAR 
The Main Menu Bar is located at the top of the HW4 main screen. 

11.1   File 
 
● Open  
 
Used to open any file present on the PC such as a log file or an event file without having to open any 
individual instrument in the device tree (see also HygroLog NT Functions - Access Data). By default File - 
Open points to the default directory used by HW4 when creating files during the initial stat-up (first time use): 
C:\Documents and Settings\Windows User\Application Data\ ROTRONIC_HW4. 
 
● Send HW4 to the Windows notification area 
 
Sends / minimizes HW4 as a shortcut icon to the Windows notification area. This area is located on the 
taskbar, immediately to the left of the clock. HW4 keeps running. 
 
● Exit  exit HW4 
 
Note: if you attempt to exit HW4 while Log to PC is active, you will get a warning from HW4. 

11.2   Devices and Groups 

11.2.1 Add master devices to the device tree 
Select Search for Master Devices and click on one of the following submenu items: 
 
•  USB Masters - HW4 searches for devices directly connected to a USB port (does not apply to the 

AC3010 adapter) 
 

• RS-232 Masters - HW4 searches for devices directly connected to either a physical COM port or to a 
Bluetooth virtual serial port. 

 
• Ethernet Masters - HW4 searches for devices directly connected to the same local area network as the 

PC (cable and / or wireless connection). 
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• Search a Specific IP Address - HW4 searches for a master device at a specific IP address specified by 

the user. 
 

 
 

11.2.2 Add RS-485 slave devices to the device tree (HW4 Professional) 
Select Search for RS-485 Slave Devices and click on one of the following submenu items: 
 
•  All RS-485 networks - HW4 searches all master devices already present in the device tree for RS-485 

slaves. HW4 will automatically change any device with the address”0” to the next available address (1 
for the master and 2 to 64 for the slaves) 

 
• RS-485 network attached to selected master – to select the master device, left click on it in the device 

tree. HW4 searches for RS-485 slaves only for the selected master device. 
 

• Search for devices connected via AC3010 adapter – the AC3010 cable allows connecting up to 64 
RS-485 slave devices to a single USB port of the HW4 PC, without requiring a master device. Because 
there is no master, all devices connected in this manner are seen by HW4 as slaves. To detect the slave 
devices, HW4 interrogates all USB ports that are not currently used by a master device. HW4 will 
automatically change any device with the address”0” to the next available address (1 to 64). 
 

• Search for devices connected via AC3011 adapter – the AC3011 converter allows connecting up to 
64 RS-485 slave devices to the HW4 PC via a single Ethernet port, without requiring a master device. 
Because there is no master, all devices connected in this manner are seen by HW4 as slaves. 
 
As a first step, connect the AC3011 to the HW4 PC or to the LAN and use the Ethernet Configuration 
Tool provided with HW4 to make the TCP/IP settings of the AC3011 converter compatible with the LAN 
to which the HW4 PC is connected. Click on the following link for instructions:  
Ethernet (TCP/IP) connection. 
 
Be sure to make a note of the IP address used by the AC3011 
 
Enter the IP address of the AC3011 when so asked by HW4. HW4 will search all RS-485 addresses 
associated with this IP address. HW4 will automatically change any device with the address”0” to the 
next available address (1 to 64). 
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11.2.3 Manual device addition 
 

Manually adding devices to the device tree can save time in some situations. Select Add Device to open the 
following form: 

 
 
All information required to fill-in the form 
must be known beforehand. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click with the mouse on the arrow located to the right of a box to display a drop down menu of available 
choices. Note that if the device is not connected or if the wrong information is entered, HW4 will put a red 
cross over the device icon in the device tree.  

11.2.4 Remove devices from the device tree 
 

• Delete Device - deletes the selected device from the left pane tree (this command is grayed out when 
no device is selected). Use this menu item after device has been disconnected 

 
• Delete all Devices from the Tree – globally deletes all devices from the left pane tree. This function 

should be used with caution 
 

11.2.5 Connection over Modem 
 
HW4 allows a single connection over a modem connected to one of the PC COM ports. In this manner, a 
device connected by RS-232 to the COM port of a remote modem can communicate with HW4. Additional 
remote devices can be connected as well, using an RS-485 multi-drop. 
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Select the COM port to which the modem is connected and enter the remote phone number. The local 
modem can be configured after clicking on the Settings button. These settings should be: 
 
Baud Rate : 57,600 
Data bits  : 8 
Stop bit  : 1 
Parity  : none 
 
Be sure to configure the remote modem in the same manner. 

11.2.6 Refresh command 
In the event that communication is lost with either a master or a slave, the refresh command can be used to 
re-establish the connection as long as the device is still present in the device tree. The refresh command 
does not add new devices to the device tree. 
 
Depending on the type of connection, use the following menu items: 
 
• Master devices:  

 
Search for Master Devices > Refresh Master Devices – HW4 refreshes all master device connections 
present in the device tree 
  

• Slaves connected to a master device (HW4 Professional): 
 
Search for RS-485 Slave Devices > Refresh all RS-485 networks – HW4 refreshes the slave device 
connections for all masters present in the device tree 
 
Search for RS-485 Slave Devices > Refresh RS-485 network attached to selected master – to 
select the master device, left click on it in the device tree. HW4 refreshes all slave device connections to 
the selected master 
 

• Slaves connected via AC3010 (orAC3011) adapter (HW4 Professional): 
 
Search for RS-485 Slave Devices > Refresh devices connected via AC3010 (or AC3011) adapter – 
HW4 refreshes the slave device connections for all AC3010 or AC3011 adapters 
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11.2.7 Groups (HW4 Professional) 
A group is a logical grouping of devices (as opposed to a physical grouping) created and defined by the 
user. Both masters and slaves can be part of a group, with no restriction other than not duplicating devices. 
Individual devices can be moved to any existing group or removed from the group (see “Devices and 
Groups”). 
 
In addition to facilitating network management within HW4, using device groups makes it possible to 
simultaneously display selected data from several individual devices within a group. The data can be viewed 
either as a table or as a live graph.  

11.2.7.1 Create / delete a Group (HW4 Professional) 
Adding and deleting Groups is done from the HW4 main menu bar > Devices and Groups 

 
• Add Group - creates a new empty group of instruments in the left pane tree (see below) 

• Delete Group - deletes the instrument group that is currently selected in the left pane. The instruments 
from the group are not deleted. 

11.2.7.2 Rename a group 
After creating a group, a menu box can be opened by right clicking on a group. The group can be renamed 
with the Rename Group command in the same manner as a file can be renamed in Windows. 
 

 
 

11.2.7.3 Add a device to a group 
After creating a group, individual devices can be moved to the group. Click on the device with the mouse 
and hold. A small rectangle appears next to the device. Drag the small rectangle on top of the group.  
Release the mouse when the name of the group is highlighted. Instruments within a group are displayed in 
the reverse order in which they were added to the group. 

11.2.7.4 Remove a device from a group 
Expand the group to display all devices within the group. Click on the device with the mouse and hold. A 
small rectangle appears next to the device. Drag the small rectangle to the bottom of the device tree, clear 
of any group and release the mouse. 
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11.3   View 
 

1• Alarm Table  – displays the alarm table 
1• User Events  – displays the contents of the user event file for the current session 

• Psychrometric Conversions – opens the Psychrometric Conversions Tool 
• Expand Tree - expands all items in the tree (left pane) 
• Collapse Tree - collapse all items in the tree (left pane) 
• Device Name - show the device name in the tree (left pane) 
• Device Type - show the device type in the tree (left pane) 
• Device Address - show the device port / IP address and RS-485 address in the tree (left pane) 
• Device Serial Number - show the device serial number in the tree (left pane) 
 
1 available only with HW4 Professional edition 
 
For details, see the following 
 
Alarm Table
User Events
Psychrometric Conversions
 
Examples: 
 
View - Device Name                                                    View – Device Type 
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11.4   Settings and Tools 
For details click on the following links: 
 
● Ethernet Configuration Tool 
 

1 ● Users and Passwords 
● Column Headers - selects the columns to be displayed in the current values table 
   (right pane) 
 
● HW4 Global Settings
 
1 available only with HW4 Professional 

11.5   Help 
 
• HW4 Help: Opens HW4 Help 
• On-line Services: When an internet connection is available, this menu item accesses the ROTRONIC 

web site where technical support, updates and product information are available. 
• About HW4: Displays the version number and ID number of HW4 
 
 

11.6   Shortcut buttons 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Psychrometric 
conversions tool 

Users and 
Passwords 1

HW4 
Global Settings 

File open 

Show / hide the alarm band on the graph for a specific 
probe and parameter 

Erase the contents of both the online buffer and 
online graph 

Show / hide the Data Cursor to display numerical 
values on the graph 

Returns the on-line graph to its initial view after 
zooming in 
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1 Available only with HW4 Professional 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 70 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

12  ETHERNET CONFIGURATION TOOL 
 
Warning: use of this tool requires basic knowledge of your LAN. If necessary, consult your network 
administrator. 
 
HW4 comes with an Ethernet device discovery and configuration tool (Digi Device Discovery). When 
activated, the configuration tool automatically detects any ROTRONIC device present on the LAN (both 
cable and wireless connections) and provides a list of all such devices. The following example shows the 
initial screen with just one device. 
 

 
 
 

Ethernet (TCP/IP) connectionFor detailed instructions see 
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13  USERS AND PASSWORDS (HW4 Professional) 
HW4 Professional allows the creation of several user accounts each with a unique user name. Each user 
must have a password but passwords do not have to be unique. At any time only one user can be logged on 
to an HW4 session. 

13.1   Minimum user rights 
All HW4 users have automatically the following minimum rights, which essentially allow the user to view 
information and data without being able to change anything important: 
 

- Start / Exit HW4 
- Log off from HW4 without exiting 
- HW4 main menu bar - Send (minimize) HW4 to the Windows notification area 
- Select which information is displayed next to the devices in the tree: name, serial number, etc. 
- Expand / collapse the device tree. 
- Access to Device Manager, Data Logging and Probe Adjustment - functionality limited to viewing data 

and other information. 
- View data in the Current Values tab (both in Device View or Group View mode) 
- View data in the On-line Buffer tab. 
- Access Data (HygroLog NT function) : limited to opening files located on the PC and viewing the file 

contents 
- HW4 Settings and Tools – HW4 Global Settings - General tab: clear both the online buffer and online 

graph 
- Users and Passwords: functionality is limited to changing own password 
- HW4 Settings and Tools – Users and Passwords: functionality is limited to changing own password 
- HW4 Settings and Tools – View user events 
- HW4 Settings and Tools – Psychrometric conversions 
- HW4 Settings and Tools – View Alarm table – the table can be viewed but alarms cannot be 

acknowledged 
 
The following is not available to users with minimum rights 
 

- Device tree: modification of the content of device groups  
- Device tree - Device Manager: any change to the configuration of a device. 
- Device tree – Data Logging: any kind of programming of a device log function. 
- Device tree – Access Data: opening, copying, moving or deleting files present on the logger. Copying, 

moving or deleting files present on the PC. 
- Device tree – Probe Adjustment – ADJUST button 
- HW4 main menu bar - File – Open 
- HW4 main menu bar - Devices and Groups menu: the entire menu is disabled 
- HW4 main menu bar - View menu: the Column Headers menu item is disabled both in Device View or 

Group View mode. 
- HW4 main menu bar - HW4 Settings and Tools menu - HW4 Global Settings: the functionality of all tabs 

is disabled 
- HW4 main menu bar: Settings and Tools – Ethernet configuration tool  
- Right pane of the HW4 main screen in Device View mode: any change to the Log to PC tab, View tab 

and OPC Server tab. These tabs can be selected for viewing but have no other functionality 
- Right pane of the HW4 main screen in Group View mode – Layout View Tab, Probe Adjustment and 

Log to PC tabs: these tabs can be selected for viewing but have no other functionality 
 
Note: when no user has been created or when no user is logged in, HW4 gives only minimum rights to 
whoever is using the PC. 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 72 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

13.2   Additional user rights 
Any user can be given a combination of the following additional rights: 
 

User Right Definition 

Manage user accounts Create, modify and delete user accounts 

Add / Remove devices 
Access to HW4 main menu - Devices and Groups - (add / 
remove devices and groups to or from the device tree). Access to 
HW4 Settings and Tools - Ethernet Configuration Tool 

HW4 global settings and view settings 
Access to HW4 Global Settings.  Ability to change the following: 
Device Tree, View Tab and Column Headers (Group or Device 
View). 

Log-to-PC function Start and stop Log to PC operations 

Change OPC settings Enable, disable the OPC tags for individual devices (OPC version 
of HW4 required) 

Device configuration / Log function  Access to Device Manager (configure individual devices). Access 
to Data Logging 

Adjust probes Access to the Probe Adjustment function.  

Acknowledge alarms 
Acknowledgement of alarms. The following two rights are 
required for defining the conditions that trigger an alarm: HW4 
Global Settings and Device Configuration / Log function. 

Read / Copy / Sign files 

HW4 Main menu – File – Open (enables all operations on files 
located on the PC) 
 
HygroLog NT - Access Data: Open and copy / or just copy files 
from the HygroLog NT to the PC. 
 
Sign log files and protocols 
 
See also notes (1) and (2) below. 

Delete files 
Delete files (HygroLog NT or PC) 
 
See also notes (1) and (2) below. 

 
(1) HW4 cannot fully protect files located on the PC, since it is always possible to use Windows to open, 
delete or move any file unless adequate security is organized within Windows, based on the Windows user 
login and Windows directory access rights. 
(2) Moving files from a device to the PC disk requires both the Read / Copy and Delete rights. 
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13.3   Creating and logging-on the first user 
From the HW4 main menu, click on the following menu item: 
 

 
 
Because no user has been created yet, HW4 automatically opens an empty user form: 
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Enter the name of the user, the user password and click on the box next to each additional right that the 
user will have. Be sure to make a note of the password. The user form may now look as follows: 
 

 
 
Click on the Add button to complete the process. 
 
IMPORTANT: the first user created in HW4 should as a minimum have the right to manage user accounts.  
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Creating a new user does not result in HW4 automatically logging on this user. To log on the first user, 
select again Users and Passwords: 
 

 
  
HW4 automatically opens the following box: 
 

 
 
Enter the name of the newly created user and the password for this user. Click on OK to log on the user. 
 
HW4 acknowledges this by displaying the name of the current user above the main menu bar:  
 

 
 
 
Note: when no user is logged in, there is no user name above the main menu bar. HW4 gives only minimum 
rights to whoever is using the PC.  
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13.4   User table form 
The user table form is available only when as at least one user exists in HW4. To open the table, click on 
User and Passwords: 
 

 
 
HW4 opens the user table form. When the current user has the right to manage user accounts, the table 
shows a list of all users currently known to HW4. When the current user does not have this right, only the 
current user is shown: 
 

 

13.5   Menu bar 
► View: use the View menu on the form to change the contents of the form by selecting one of the options 
shown below: 
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► User Operations: this menu item gives access to the following: 
 

 
 
 
► View / change user data and rights, Create a new user and Delete user: Any of these selections will 
    require the current user to re-renter his / her password: 
 

 
 
► View / change user data and rights: full access to this function requires the current user to have the 
    right to manage user accounts. For other users, the function is limited to being able to change the current 
    user password. 
 
► Create a new user and Delete user: any of these selections require the current user to have the 
     “manage user accounts” right. 
 
► Suspend user and Reinstate user: any of these selections require the current user to have the 
     “manage user accounts” right.  
 
Creating a new user is done in the same manner as creating the first user. When changing or deleting a 
user, use the mouse to select the user from the list provided by the user table form: 
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IMPORTANT: HW4 keeps track of all users that have been created, even users that have been 
subsequently deleted. Please note that the name of a user that has been deleted cannot be used again 
(use “Suspend User” when you want to be able to use the user name again).  
 
► Log-on a different user: selecting this item open the user log-on form. By default, the form shows the 
    name of the user that is currently logged-on. To change the user, use the mouse to highlight the user 
    name and type in the name of the user to be logged-on. Enter the password for that user. Click on the OK 
    button. The current user is logged off and the new user is logged on. 
 

 
 
Note: clicking on the Exit button logs off the current user but does not log on the new user. 
 
► Log off current user: selecting this item logs off the current user, without logging on any specific user. 
     When using HW4 Professional, selecting this menu item without logging-on a user may prevent access to 
     most of the HW4 functions and screen views. To return HW4 to the desired level of functionality, log-on 
     as a user with sufficient rights. 

13.6   User login security 
o Attempts to login with the wrong password are now being recorded. 
o HW4 startup will be aborted after 3 attempts with the wrong password 
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14  COLUMN HEADERS 
Column Headers is used to customize the Current Values Tab both in the Device View Mode and in the 
Group View Mode. 
 
To make HW4 display only specific columns in the Current Values tab: 
 

• In Device View Mode: select any individual device present in the device tree (for example HyGen 
Lab 2 in the left pane). In the HW4 main menu bar, click on Settings and Tools and on Column 
Headers. 
 

 
 
HW4 opens the following form. Make your selection using the mouse. The selection applies 
globally to any other device when displayed in the Current Values tab. 
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• In Group View Mode: select a device group that is present in the device tree (for example RIC LAN 
in the left pane). In the HW4 main menu bar, click on Settings and Tools and on Column Headers. 
 

 
 
HW4 opens the following form. Make your selection using the mouse. The selection applies 
globally to any group when displayed in the Current Values tab. 
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15  HW4 GLOBAL SETTINGS 
This menu item opens the HW4 Global Settings Form. 

15.1   View Tab 
 

 
 
Start-up Form: 
 
• Bypass: display or bypass the HW4 start-up form (log-in with password is still required) 
 
General: 
 
• On-line graph: shows or hide the graph in the Current Values tab 
 
• HW4 background pictures: select or deselect to modify the appearance of several forms used in Device 

Manager, HW4 Explorer, etc. 
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Start-up Tab: 
 
• Current Values / On-line Buffer: select the desired default tab for the right pane of the HW4 main screen 
 
• Trend Indicators: HW4 can display to the right of each current value an indicator that shows if the value 

is stable (equal symbol), increasing (+ symbol) or decreasing (- symbol). The status of this indicator is 
read by HW4 directly from the device/instrument being monitored. 
 
Note: this function works only for instrument models that send the status of the trend 
indicator 1 to HW4 and is not available in Group View mode. 
 
1 Instruments such as the HygroFlex and HygroLab send the status of the trend indicator only for the two 
parameters that are being shown on the local LC display.  

 
• Font Size in the Current Values data table: the default value is value 10. Use a value of 20 or larger to 

make it easier to read the PC monitor from a distance. Use the mouse to resize each column of the data 
table as required. 

 
 

 
 

 
 
• After starting HW4, send as a shortcut to the Windows notification area: The Windows notification area is 

located on the taskbar, immediately to the left of the clock. HW4 can now be sent (minimized) as a 
shortcut icon to the Windows notification area while it is still keeps running. The alarm table will still 
appear on the PC monitor when HW4 is running in this mode. 
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15.2   General Tab 
 

 
 
Communication: 
 
• Enable Device Polling: Put a check mark in this box to enable HW4 to establish the initial (start-up) 

communication with the devices present in the device tree and to read / update data from these devices 
at regular intervals of time (polling interval). The data read by HW4 is used to populate the right pane of 
the HW4 main screen (current values table, on-line buffer and on-line graph). 
 
If you are going to use HW4 only to the purpose of configuring or programming instruments and are not 
interested in any measurement data, you may want to temporarily uncheck this box by clicking on it with 
the mouse. HW4 will no longer read and update the data from the devices in the tree and the right pane 
of the HW4 main screen will be blank. We recommend restoring the check mark prior to closing HW4 so 
as to allow HW4 to communicate at least once with the devices in the device tree during the next start-
up. 

 
• Polling interval: enter here the time interval to be used by HW4 when polling the devices connected to 

the HW4 PC. The minimum value of 5 seconds is also the HW4 default. 
 
Note: the other adjustable time intervals used by HW4 (on-line buffer / graph update and log-to-PC) 
should be a whole multiple of the polling interval and should be at least equal to the polling interval. 
When enabled, OPC tags are updated as per the polling interval. 
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• On-line buffer time interval: enter here the time interval to be used by HW4 when writing data to the 

on-line buffer. The minimum value is 5 seconds. The on-line graph is updated using this time interval. 
 

• On-line buffer size: specify here the number of lines for the on-line buffer. The size of the on-line buffer 
also determines the amount of data shown in the on-line graph. 

 
• Clear both the online buffer and online graph: click on this link to clear both the buffer and the graph. 

After clicking on the link, you can exit HW4 Global Settings by clicking on the Cancel button (HW4 will 
not generate a protocol). 
 
When adjusting a probe, clear the online buffer when the probe appears to have reached equilibrium. 
This forces the automatic scale of the graph to the highest resolution. 

 
Bluetooth serial ports: 
 
• The Bluetooth serial ports text box is used to declare the virtual serial port(s) used by Bluetooth enabled 

devices. Only the number of the serial port should be entered in the box (example: enter the number 8 
for COM8). When several Bluetooth devices are used, enter each Bluetooth serial port number, 
separating each number with a semi-column. Do not use a space in between numbers (example: 8;10). 

 
Automatic Functions: 
 
• Enable system monitoring: check this box to have HW4 keep a record of any software problem that 

may occur. Keeping this type of record is an ERES regulatory requirement. HW4 event files have the 
extension ERR and are located in the subfolder EVENT of the HW4 user folder. When support is 
required from ROTRONIC, troubleshooting the problem is greatly facilitated when the corresponding 
HW4 event file is available. 

 
• Force password change: this feature is only available with HW4 Professional. Enable this feature to 

force users to change their password on a regular basis. 
 
• Enter password again after 30 minutes: this feature is only available with HW4 Professional. Enable 

this feature to force users to enter their password again after the time indicated. This is an ERES 
regulatory requirement which provides additional protection in the event that HW4 is running and left 
unattended for a period of time. 

 
• HW4 updates notification: check this box to be automatically notified of new updates. This feature 

works only if the PC has access to the Internet. 
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• ROTRONIC NEWS: check this box to be automatically notified of new issues of ROTRONIC NEWS. 
This feature works only if the PC has access to the Internet. 

 
• Automatic synchronization with PC clock: Enable this feature to allow HW4 to automatically 

synchronize any device internal clock with the HW4 PC clock. Synchronization takes place daily at 2:00 
am and each time that HW4 is started. In order to be synchronized, the clock of the device must differ 
from the PC clock by at least 1 minute. 
 
Do not use this function when the PC and some of the polled devices are located in different time zones. 
See also: Device Protection 

 
• Auto-start mode: the auto-start mode allows HW4 to start without requiring a user to log in. HW4 logs-in 

the fictitious user “autostart”. This user does not have to be created in HW4 and is given only the 
minimum HW4 rights. The auto-start mode can be used to allow a client application that connects to the 
HW4 OPC-server (OPC tags) to automatically start HW4. 
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15.3   Language/Unit System Tab 
 

 
 
The selections and values entered in this tab affect only the language used in HW4 menus and the unit 
system and fixed pressure value used by the Psychrometric Conversion Tool. This tab has no effect on the 
instruments and devices in the tree. When HW4 displays or records data from any instrument, both the unit 
system and any fixed pressure value are determined by the configuration of the instrument. 
 
• Language: click on the underlined link to change the language used in the HW4 menus and forms to 

one of the available languages. The link opens the folder where the language files are located (these 
files have the extension .txt as in English.txt). To change the language, simply click on the appropriate 
file. The selection made here has no effect on the devices in the tree. 
 
Note: After changing the language selection, you should close and re-open HW4 to ensure a complete 
updating of all HW4 texts.  

 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 87 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

• Unit System: use the underlined links to the right of the form to globally change the unit system used 
within the HW4 Psychrometric Conversion Tool. The English the unit system offers two choices: In Hg or 
PSI for pressure. Choose a unit by clicking on the arrow to the right of each text box. Relative humidity:  
the symbol to be used after the % symbol (RH) should be typed in the text box. 

 
• Constants: 

 
Fixed pressure value: enter here the default fixed pressure value that will be used within the HW4 
Psychrometric Conversion Tool to compute calculated parameters such as wet-bulb temperature, mixing 
ratio, etc. The barometric pressure value can be temporarily changed from within the Tool but it reverts 
to the default value each time the Tool is opened. 
 
The numerical value entered here should be consistent with the pressure unit that was selected under 
Unit System. 
 
Activation energy: enter here the value to be used in the calculation of the mean kinetic temperature 
(MKT). MKT is part of the statistical data that can be seen when using the HW4 log file viewer. 
 
The activation energy should always be entered in kJ/mole, regardless of which unit system (metric or 
English) is being used. Typically, a value between 60 and 100 kJ/mole may be used for liquids and 
solids. 
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15.4   File Locations Tab 
 

 
 
Use this tab to review or change the location of the files created by HW4. Click on the button to the right of 
the path field to browse for drives and folders. 
 
• Logger data files: log files copied from the logger to the PC. These files have either the extension XLS 

(unprotected) or LOG (protected binary format) 
 

• Log to PC files: log files directly recorded on the PC. These files have either the extension XLS 
(unprotected) or LOG (protected binary format) 

 
• User Folder Path: This folder is used to hold the HW4 configuration file (HW4.ini) as well as the data, 

event and protocol files created by HW4. If you wish to change the path of the HW4 User Folder, see: 
Relocating the HW4 User Folder. 
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• Device configuration files: these files have the extension DAT and are used to retain typical instrument 
configuration data so as to be able to quickly configure a number of instruments. 

 
• Protocols: these files have the extension TXT and keep track of configuration changes to an instrument, 

instrument programming (such as data logging) and probe adjustments. 
 

• Device event files: these files have the extension EVT and are generated by the data logger to keep 
track of the main internal logger events. 

 
• Alarm records: HW4 maintains a file named HW4Alarm.alr to hold all alarm record. 
 
• HW4 event files: these files have the extension ERR and keep track of any software problem 

encountered by HW4. 
 
• User event files: these files have the extension EVT and keep track of the main operations performed 

by each HW4 user (HW4 Professional only). See also Record keeping by HW4 
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15.5   Graph Settings Tab 
 

 
 
Use this tab to customize the default appearance of the graphs generated from log files. Graphs settings can 
also be customized for each individual log file when it is being displayed in HW4 View Data. Most of the 
settings in this tab do not apply to the on-line graph displayed in the Current Values tab. 
 
• Show Background Picture: enables the background picture. 
 
• Line box: when generating a graph, HW4 uses lines 1 to 24 as follows: line 1 = humidity probe 1, line 2 = 

temperature probe 1, line 3 = calculated parameter probe 1, line 4 = humidity probe 2, etc. If a probe is 
not connected or if a parameter is not present on the graph, HW4 does not make use of the 
corresponding line. The properties of each line (type, color, weight, etc.) can be customized after right 
clicking with the mouse on the line. 
 
When the box Show legend is checked, use one of the four radio buttons around the line box to set the 
position of the legend on the graph. 
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• The color of the grid, selected trace and data cursor can be changed after clicking with the mouse on the 
corresponding line. 
 

• Automatic scaling: leave this box unchecked if you wish to manually define the sale for the primary and 
secondary Y axis of the graphs. Each axis can have its own scale. The secondary axis is used for 
temperature and the calculated parameter (see example below) and is not available with the on-line 
graph. 
 
Example of manual scaling: 
 
When the box “Automatic scaling is unchecked”, the form changes and two sets of two test boxes 
appear to let the user specify the minimum and maximum values for the scale of the primary Y axis (left) 
and for the scale of the secondary Y axis (right). 
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The results may be as illustrated in the graph below: 
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15.6   Alarm Settings Tab (HW4 Professional) 
 
This tab is used to set HW4 to track and report conditions and events that are deemed to be abnormal, such 
as: 
 
• Loss of communication with any device present in the device tree 
• Measured values that are out limits or are not available (see Device Manager - Input and Optional Input) 
• Device alarm: depends on the type of alarm conditions that are monitored by each specific device 

connected to the PC. Examples: bad sensor, bad memory card, etc. 
• Unavailability of the file location (path) used by HW4 while recording data to the PC (example: 

disconnected network drive) 
• Internal HW4 software errors / malfunctions 
 
The HW4 alarm settings provide a high level of flexibility regarding both the definition and processing of 
alarm conditions. HW4 allows multiple levels of alarm and action that can be defined by the user, based on 
the severity of an alarm condition or on other factors. 
 

Alarm indication and reporting by HW4 For a general overview, see “ ” in this manual. 
 

 
 
 
IMPORTANT: 
 
• The different modules available within this tab can be 
   selected from the left pane of the Alarm Settings tab 
. 
• Click on the OK button (bottom right corner of the form) to 
   enact and save any change 
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► GLOBAL ALARM SETTINGS 
 

 
 

 
 
• Archive Alarm Records after [Months]: this setting is used to limit the size of the alarm records file 

(…\ROTRONIC_HW4\EVENT\HW4Alarm.al2). Enter here how old an alarm record must be in order to 
be automatically archived. Alarm archive files use the following naming convention 
 
 …\ROTRONIC_HW4\EVENT\HW4Alarm_YYYYMMDD.al2 
 
where YYYYMMDD is the time stamp of the first alarm record present in the file 
 

• Archive File Size Limit: enter here the maximum number of alarm records that can be held in a single 
archive file (5,000 records typically require 1 MB). When the archive file currently in use reaches the 
limit, HW4 creates a new archive file.  
 

•  Run Control Timeout [min]: the Run Control alarm acts like a watchdog. HW4 updates a time stamp 
during each polling interval (HW4 time stamp) or whenever new measurement data is received from a 
device (device time stamp). Every minute, HW4 verifies that the time elapsed since the most recent time 
stamp is less than the limit specified under “Run Control Timeout” 
 

• Test Alarm Interval [Hours]: enter here the interval to be used by the HW4 Test Alarm automatic 
function 
 
The form provides a link to manually trigger a Test Alarm 
 

• E-mail Settings: 
 
MAPI: HW4 will use Microsoft Outlook to end an email. Recent versions of Microsoft Outlook require a 
manual authorization each time that a third party software attempts to use Outlook to send a message. 
This will prevent HW4 from sending mail when the PC is unattended. 
 
SMTP: HW4 will send an email directly to an outgoing-mail (SMTP) server. This can be done 
automatically, even when the PC is unattended. When required by the SMTP server a user name and a 
password can be entered. 
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The form provides a link to manually test the e-mail settings 

► LIMITS 
 
The Limits module is used to create, copy or delete Limit Sets. A Limit Set consists of low and high limit 
values that apply to the humidity, temperature and calculated parameter of up to 7 probes connected to the 
same device. Creating several Limit Sets is useful when the process being monitored requires several levels 
of alarm, each with its own actions. The available Limit Sets are listed in the left pane of the form. 
 
• Creating a new Limit Set 

 
 
 
 
 
 
 
 
 
 
 

 
1) Click on the “Create” button or select an existing Limit Set from the combo box located to the right of 
    the “Copy” button, and click on the button. The new Limit Set appears in the left pane of the form. 
 
2) Click on the new Limit Set in the left pane of the form. This opens the form shown below. 
 
3) Type a new name for the Limit Set in the Name field (for example: Limit Set 1) 
 

 
 
 
 
 
 
HW4 allows creating an unlimited 
number of Limit Sets which 
correspond to different levels of 
severity 
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n 

 
 
 

► PROCESSING 
 
The Processing module is used to create, copy or delete alarm processing sets. The available processing 
sets are listed in the left pane of the form. 
 
• Creating a new processing set 

 
 
 
 
 
 
 
 
 
 
 

1) Click on the “Create” button or select an existing processing set from the combo box located to 
     the right of the “Copy” button, and click on the button. The new processing set appears in the left 
     pane of the form. 
 
2) Click on the new processing set in the left pane of the form. This opens the form shown below. 
 
3) Type a new name for the processing set in the Name field (for example: Process 1) 
 

 
 
 
 
HW4 allows creating an unlimited number 
of processing sets which determine how a
alarm condition is processed. 
 
 
 
 
 

 
• Delayed Alarm: check the box to enable this feature and select one of the following options: 

 
a) Time Delay: this is the minimum amount of time during which an alarm event must persist for  
     HW4 to process the alarm event. 
 
b) Polling Intervals: this is the minimum number of contiguous polling intervals which must detect 
    an alarm event for HW4 to process the alarm event.  The polling interval can be set in 
    HW4 Global Settings > General tab. 
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• Repeat Alarm Actions: check the box to enable this feature and enter the following settings: 

 
a) Times to repeat: this the maximum number of times that the actions associated with the alarm will be 
     repeated. HW4 stops repeating the actions as soon as the alarm event disappears.  HW4 offers the 
     option to stop repeating the actions as soon as the alarm is acknowledged from within the 
     Alarm Table. 
 
b) Interval: amount of time in between repeated alarm actions 

 
 
 
Note: an alarm event for which 
actions are being repeated is 
entered only one time as a record 
in the alarm records file  
 
 

 
 

• Time Schedule: check the box to enable this feature. Select the desired configuration settings : 
 

 
 
HW4 will not report, create an alarm record or take any other action for alarm events that occur outside 
of the time schedule. 
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► ACTIONS 
 
The Actions module is used to create, copy or delete sets of actions to be carried out when an alarm occurs. 
The available Action Sets are listed in the left pane of the form. 
 
• Creating a new set of actions 

 
 
 
 
 
 
 
 
 
 
 
 

1) Click on the “Create” button or select an existing action set from the combo box located to 
     the right of the “Copy” button, and click on the button. The new action set appears in the left 
     pane of the form. 
 
2) Click on the new action set in the left pane of the form. This opens the form shown below. 
 
3) Type a new name for the action set in the Name field (for example: Action Set 1) 

 
 

 
HW4 allows creating an unlimited 
number of action sets 
 
 
 
 
 
 
 
 

 
• Send Email: check the box to enable this feature. Enter the address of the mail recipients (one recipient 

per line, no separation character) 
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• Give Acoustic Signal: check the box to enable this feature. Select the desired sound file 

 

 
 
 

• Print Report: check the box to enable this feature. Select the desired printer 
 

 
 
 
 

► TRIGGERS 
 
The Triggers module is used to create, copy or delete Trigger Sets. A Trigger Set cannot be deleted as long 
as it is assigned to one or more devices. The available Trigger Sets are listed in the left pane of the form. 
 
• Creating a new trigger set 

 
A Trigger Set consists of one or more Triggers (or abnormal conditions) each associated with a priority 
level, a time schedule and an action set.  
 
After creating the necessary Limit Sets, Processing Sets and Action Sets, you are now ready to create 

one or several Trigger Sets 
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1) Click on the “Create” button or select an existing trigger set from the combo box located to 
     the right of the “Copy” button, and click on the button. The new trigger set appears in the left 
     pane of the form. 
 
2) Click on the new trigger set in the left pane of the form. This opens the form shown below. 
 
3) Type a new name for the trigger set in the Name field (for example: Trigger Set 1) 
 
4) Click on the “Add Trigger” button (bottom right corner of the form) to create a new line in the triggers 
    table 
 

 
 

• Triggers: click on the arrow to the right of the combo box to display a drop down list of HW4 
pre-defined triggers as well as a list of the Limit Sets that you have previously created. Select one item 
from the list. 
 

• Priority: click on the arrow to the right of the combo box to display a drop down list of HW4 
pre-defined priority levels. Select one item from the list. 
 

• Processing (optional): click on the arrow to the right of the combo box to display a drop 
down list of the Processing Sets that you have previously created. Select one item from the list. 
 

• Actions (optional): click on the arrow to the right of the combo box to display a drop down 
list of the Action Sets that you have previously created. Select one item from the list.  
 
NOTE: a trigger set can have as many lines as desired. Any unwanted trigger can be deleted by clicking 
on it and then clicking on the “Remove Trigger” button( bottom right corner of the form) 
 
 
 

 
 
HW4 allows creating an unlimited number of trigger sets 
 

► DEVICE ASSIGNMENT 
 
This module is used to assign each individual device present in the HW4 device tree to one of the available 
Alarm Trigger Sets or to no trigger set at all. See further down for the definition of an Alarm Trigger Set. 
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Regardless of the assignment status, any individual device reporting an alarm condition appears in red in 
the device tree. Device groups also appear in red when a member of the group reports an alarm condition. 
Values that are out of limits appear in red in the Current Values Tab, both in Device View and in Group 
View. Other types of alarms appear also as a red text in the Current Values Tab (low battery, simulator 
mode, etc.) 
 

15.7   Events Tab (HW4 Professional) 
 

 
 
• Authentication stamp: HW4 Professional automatically generates an authentication stamp at the 

end of protocols and this stamp is cross referenced in the user event files. Check this box to have HW4 
validate the authentication stamp when opening a protocol (file with the extension TXT): instrument 
configuration, instrument programming and probe adjustment. HW4 uses the authentication stamp to 
verify that the protocol file has not been altered. 
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• Enable monitoring of user events: check this box to have HW4 generate and maintain a user 

event file keeping track of the main operations performed by any user. This is an ERES regulatory 
requirement. 

 
• View user events: click on this link to view the contents of the user events file. 

 
• Generate and Save Protocols: check this box to have HW4 automatically generate and save to 

disk a protocol file recording the details of the following operations: device configuration, log function 
programming (except log-to-PC) and probe adjustment. 
 
HW4 generates protocols in simple text format (Editor / Microsoft Notepad - file extension TXT). 
 

• Display Protocols on the PC Monitor: This selection causes HW4 to automatically display the protocol 
on the PC monitor. This option cannot be selected without selecting Generate and Save Protocols. 
 
Note: for a complete overview, see “Record keeping” in this manual. 

15.8   AwQuick Mode Tab (HW4 Professional with AwQuick) 
 
The tab is used to configure the water activity measurement function of HW4. 
 
See Water activity measurement modes in HW4
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Note: the values shown above are the most frequently used. 
 
IMPORTANT: Both the selected mode and its settings apply globally to all instruments and probes. 
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16   USER EVENTS (HW4 Professional) 
 
When HW4 is enabled to do so (HW4 Global Settings – Events Tab), a user event file is created and 
maintained. For more information, see “Record keeping by HW4” in this manual. 
 
The following are examples of user events: 
 
o User login / logout 
o Changes to the HW4 Global Settings 
o Instrument configuration 
o Log function operations, etc. 
 
Proceed as follows to view the user event file for the current session of HW4: 
 

 
 
HW4 opens the user event form. By default, HW4 displays only the events of the current session: 
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16.1   Menu bar 

16.1.1 Load previous user events 
 
To view every user event recorded by HW4 since a specific date, proceed as follows: 

 
 
 
In the menu bar of the user events form, click on File and then 
click on Load previous user events. 
 
 
 
 
 
 
 
 

 
HW4 displays a dialog box: 

 
Click on the arrow to the right of the date field to open a calendar. 
 
Select the oldest date from which you want to see all user events on 
record and click on the OK button. HW4 loads in the user event form 
all user events on record since the selected date. 
 
 

 
Note: the next time that the user event form is opened, HW4 will display again only the events of the current 
session. 

16.1.2 Print 
 
This command prints the current contents of the user event form (current session only or every event 
starting from a specific date). 
 

16.1.3 Save As 
 
The contents of the user event form (current session only or every event starting from a specific date) can 
be saved to a file with the extension XLS.  
  



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 107 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

17  ALARM TABLE (HW4 Professional) 
Alarm indication and reportingFor an overview of the alarm function in HW4 see . 

 
The HW4 alarm table displays the contents of the alarm records file and can be shown on the PC monitor at 
any time from the HW4 main menu bar:  
 

 
 
 
When one or several alarm conditions occur, this is reported on the bottom left corner of the HW4 main 
screen.  

 
Click on the bold red text to open the Alarm table. 
 
After opening the Alarm Table the text disappears 
 
 

 
The contents of the Alarm Table can be customized by any HW4 user with sufficient rights. Alarm conditions 
that are presently in effect are shown with a red exclamation mark. The red exclamation mark is 
automatically removed when the alarm condition no longer exists. 
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17.1   Alarm acknowledgement 
 
Acknowledging an alarm requires the current user to have to the right to do so.  
To acknowledge an alarm, double click on the alarm line in the table. The following dialog box opens: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
An alarm can be acknowledged several 
times. Prior acknowledgments can be seen 
in the top text field 
 
 
 
Enter a new acknowledgement text in the 
bottom text field. Click on the OK button 
when done. 
 

Acknowledged alarms are shown in the table with a check mark as illustrated below: 
 

 
 
 
Acknowledging an alarm or clicking on the EXIT button does not reset the alarm. The acknowledged check 
mark simply means that a qualified user knows about the alarm and may have entered a comment. An alarm 
that is current (active) remains visualized in the main HW4 screen (using the color red in the group / device 
tree and in the current values table). 
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17.2   Alarm table menu bar and buttons 
 

  

17.2.1 File 
 
• Print Summary Report: prints the current contents of the alarm table as a report 
• Save As: saves the current contents of the alarm table in the Microsoft Excel format 
• Load Archive: select an Alarm Records archive file to be loaded to the Alarm table 
• Exit: closes the alarm table 

17.2.2 View 
 
Use View to change display the alarm records selectively: 
 

 
 
Use the arrow buttons or the Navigation menu 
to change the day, week or month 
 

 
Changes the record font from bold to normal
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17.2.3 Options 
 
• Customize contents: the information appearing both in the alarm table and in the alarm report can be 

customized. Clicking on “Customize contents” opens the following form: 

 
 
 
The selected items appear as columns in the alarm table and 
as lines in the alarm summary report. 

 
 
  
The order of the columns within the alarm table can be 
changed by clicking and dragging them with the mouse. 

 
 
  
When the value that triggers an alarm is a calculated 
parameter such as dew point, the symbol for that parameter 
appears in front of the numerical value in both the alarm 
table and alarm report. 
 
Example:  Fp: -16.58°C 

 
 
 
 
 
 
  

 
 
 
 
 
 
 
 
 
 

17.2.4 Alarm table buttons 
 

 
 
 

Change the date or date range of the alarm events to be 
displayed 

 
 
 
 

Display only non-acknowledged alarms  
 
 Display only current alarms 
 
 

Select which alarm priority levels are to be displayed in the 
alarm table (white background = selected) 

 
 

  
Green : low priority  
Yellow : Medium priority  
Red : High priority 
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18  PSYCHROMETRIC CONVERSIONS 
 
This menu item opens a form that can be used to convert humidity parameters. To change the parameter to 
be converted, click on Input Parameter and choose from the list. 
 

 
 
o Click on the blue arrow to compute 
 
o Click on the diskette symbol to transfer the results to the default Windows text editor (such as Notepad) 

and eventually save the data to a text file. 
 

o Click on File > Save Calculations to save the results to a text file named Calculate.txt that is saved in the 
folder ROTRONIC_HW4\DOC (see Location of the HW4 User Folder). Generate and save Protocols” 
must be enabled in HW4 Global Settings > Events tab. The contents of Calculate.txt are changed each 
time that a new calculation is saved. 

 
Note: to change the unit system, go to the HW4 main screen. In the menu bar, click on Settings and Tools 
and on HW4 Global Settings. In the HW4 Global Settings form, select the tab “Language / Unit System”. 
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19  DEVICE PROTECTION 
This function is used to protect a device 1 against malicious users. This is particularly useful when the device 
is exposed to the Internet. When a device is protected, the following functions are disabled:  
 
o All Device Manager functions 
o Log function programming 
o Probe adjustment 
o Deletion of files from the device memory card 
 
1 Availability of this function depends on the firmware version of the device. 
 
Warning: The following HW4 automatic functions are also disabled for the protected device: 
 
o Automatic address change when adding new devices to a RS-485 multi-drop network 
o Automatic synchronization with the HW4 PC clock 
 
The procedure used to protect or unprotect a device is described, using the HygroClip DI as an example: 
 
Select the device in the device tree and open Device Manager > Device Information: 
 

 
 
To protect the device, click on the underlined link. HW4 opens the following form where a password can be 
entered (maximum 8 characters): 
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Enter the password and click on the OK button. HW4 confirms that the device is now protected: 
 

 
 
To unprotect the device and enable all functions, click on the underlined link. HW4 opens the password 
form: 
 

 
 
Enter the password and click on the OK button. HW4 confirms that the device is now unprotected. 
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FORGOT THE PASSWORD? - should you forget the password, remove power from the device (HygroLog 
NT: remove the battery). After restoring power to the device, you have about one minute to use the default 
password !resume! (include the exclamation marks). After one minute the default password is no longer 
accepted. 

20  ACCESSING LOG FILES, PROTOCOLS AND EVENT FILES 
 
All files generated by HW4 can be accessed from the HW4 main menu bar provided that they reside on the 
PC. 
 
1. Select File and Open: 
 

 
 
2. HW4 opens the following form 
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By default, the menu item File - Open (HW4 main menu bar) points to the HW4 User Folder 
ROTRONIC_HW4 (see Location of the HW4 User Folder). When the location of the files has been 
changed from the default location, you will have to manually look in the proper folder. 
 
3. Select the folder where the type of file that you want to open is located: 
 
● DATA: log files that have been copied or transferred (moved) from the data logger to the PC. 
 
● DATA_ONLINE: log files directly created on the PC (Log to PC). 
 
● DOC: protocol files (device configuration, logger programming and probe adjustment). 
 
● EVENT: user event files as well as HW4 event files. 
 
● SYS: frequently used device configuration files for future use with Device Manager 
 
Example: Protocol files folder 
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4. Select the proper file extension for the type of file you want to open, or select All files *.*. 
    If you do not see any file, check the folder and file extension selections. 
 
5. Select a file with the mouse and click on the “Open” button. 
 
Depending on the type of file, HW4 uses different file viewers. 
 
Log files  : see View / Sign a Log File
Protocols : see View / Sign a Protocol
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21  VIEW / SIGN A PROTOCOL 
HW4 uses the following viewer to display protocols on the monitor screen. 
 
Example: 
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HW4 always checks the authentication stamp of a protocol when opening the file. The result of this 
verification appears on the bottom left corner of the form used to display the file contents: 
 

 
 

 
 

21.1   Protocol viewer menu bar 
 
File 
 
• Print: opens the Windows printer form and prints the protocol on the specified printer. 
 
• Sign document: use this menu item to add your HW4 user name and a comment text to the protocol. 

For authentication purposes you will need to enter your password. 
 

 
 
• Exit: closes the viewer. 
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View 
 
• Document: displays the entire document in the viewer. 
 
• Signature: displays only the signature area of the document. 
 

 
 

22  VIEW / SIGN A LOG FILE 
 
View Data is the graphic module of HW4. 

22.1   Opening a log file in HW4 View Data 
 
A log file that is located on the PC can be opened in View Data from the File menu in the HW4 main menu 
bar. 
 
Select File and Open: 
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HW4 opens the following form 
 

 
 
Select the folder where the file is located (DATA or DATA_ONLINE) as well as the type of log file (file with 
.LOG or .XLS extension). If you do not see the file, check the folder and file extension selections. Click on 
the “Open” button. 
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HW4 immediately opens the file in View Data: 
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Click with the mouse on the tab with the file name to view the data in a table. 
 

 
 
Click with the mouse on the Graph tab to view the data again in a graph. 
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22.2   View Data menu bar 

22.2.1 File 
• Overlay another file: this menu item is available only with HW4 Professional and allows bringing 

several log files into a single graph (the maximum number of files depends on the size of the files). Note 
that the files to be overlaid must be present on the PC (if necessary, begin by copying the desired files 
from the logger to the PC). The files being overlaid can be a mixture of the LOG and XLS format. 
 
Note: Files recorded with the HygroLog NT can be started all at the exact same time. By contrast, this is 
not possible when recording several inputs on the PC as illustrated in the picture below. 
 

• The Save As command offers the possibility of saving the overlaid data under a new file name. The new 
file is always in the XLS format and it separately retains the file header and the data from each original 
file. The new file is not write protected. After overlaying two or more files, it sometimes makes sense to 
view the data with a common time origin. For instructions, see Options – Overlay synchronization.  

 

 
 
• Save: Saves a file located on the PC to its original location under the original file name. This command 

will not work when the file is Write protected and therefore cannot be used with the original files created 
by HW4. 

 
• Save As: saves a copy of the file to any location on the computer. The file is always saved in the .XLS 

format. This command can be used to do the following: 
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- Convert a binary log file (LOG) to the text format (XLS) and save the converted file to disk, 
  under a new name (the original LOG file is still available) 
- Save a write protected file under a new name after adding notes, text boxes, etc. 
- Save the results of overlaying several files under a new file name. The new file separately 
  retains the file header and data of each original file. 

 
• Print: the effect of this menu item depends which tab (Graph or File Name/Data Table) is selected in 

HW4 View Data. The command opens the Windows printer form and prints the graph or table on the 
specified printer. 
 
► Graph: the log file name is added to the top of the graph when the graph is being printed. 
 
► Data table: the file header is always printed before the table. It is possible to select with the mouse a 
number of lines from the data table, prior to printing. Depending on the selection made within the 
Windows printer form, either all of the data or just the selected lines will be printed. 

 
• Sign document: use this menu item to add your HW4 user name and a comment text to the 

   log file. For authentication purposes you will need to enter your password 
. 
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Signing a log files creates an additional tab in View Data: 
 

 
 
 
● Exit: exits HW4 View Data 

22.2.2 View 
 
● Initial View 1: returns the graph to the view used by HW4 View Data when opening the file 
 
● Previous View 1: after using the magnifying glass or zooming on a graph area several times, returns the 
graph to the previous view 2
 
● Next View 1: changes the graph to the next view when the magnifying glass or zoom has been used 
several times 2
 
● Graph time window 1: used to select the time window corresponding to the graph X axis. The available 
selections appear in a submenu: Hour, Day, Week, Month or Year. For example, selecting Day, makes the X 
axis correspond to a 24-hour time window. 
 
● Next time window 1: used to increment the origin of a time window (X axis) by one time window unit. For 
example, if the graph is displaying a week worth of data, this command changes the graph to the following 
week. 
 
● Previous time window 1: used to decrement the origin of a time window (X axis) by one time window unit. 
For example, if the graph is displaying a week worth of data, this command changes the graph to the 
previous week. 
 
● Toolbar: shows or hides the toolbar (the toolbar shortcut buttons are used only in graph view and 
duplicate a number of items of the View menu). 
 
● Notes: shows or hides the Notes tab. This tab allows extensive notes to be associated with the log file. To 
retain these notes, a write protected file should be saved under a new name 
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1 this item is grayed out when the Graph tab is not selected 
2 this item is context sensitive and is grayed out when not applicable 

22.2.3 Tools 
 
● Merge the overlays 1: when several log files have been opened using the HW4 View Data File menu and 
Overlay another file, this menu item merges the files into a single file (single data table and a single graph). 
Merging the overlays should be used only when there is no overlapping time between the log files (otherwise 
the merge results will not make sense). The new file created with this command can be saved in .XLS 
format, under a new name, using File – Save As. 
 
1 This menu item is available only with HW4 Professional 
 
Example: 
 
Two log files are overlaid into a single graph, prior to being merged into a single file. 
 
Note: the recording time of the two files does not overlap. 
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The results of merging data from the same two log files into a single file:  
 

 
 
The two tabs with the original file names have been replaced with a single tab labeled Table. Data points 
that were initially separated by a time interval are now joined. 
 
Note: The header of the merged file is the header of the first file that was opened. The headers of the other 
files are lost. For example, if the other files have alarm settings that are not the same as the first file, this 
information will be lost. 
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● Overlay synchronization 1: when the data from different files was not all recorded starting at the exact 
same time, it is sometimes useful to use a common time origin for viewing view all traces after overlaying the 
files in a single graph. The effect of this menu item is to shift some of the traces data along the graph time 
(X) axis. The actual time corresponding to a number of data points is lost as far as the graph is concerned, 
but this can be reversed. 
 
1 This menu item is available only with HW4 Professional 
 
 This command opens the following sub-menu: 
 

- Earliest time 
- Hour 
- Day 
- Week  
- Month 
- Year 
- Undo 
 

Earliest time: causes HW4 to use the earliest time found in the log files as a common time origin for all data 
in the graph. 
 
Hour, Day, Week, Month or Year: causes HW4 to use the top of an hour (such as 11:00) or the beginning of 
a day, week, month or year as the common time origin for all data. Using any of these selections makes 
sense only when the log data spans a sufficient length of time. For example, do not select Day if the log data 
does not cover more than a day.  
 

Undo: reverses the current synchronization and must be used before applying a different synchronization 
method. 

 
Example: Initial result after overlaying two files started at a different time 
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After synchronizing the files based on “earliest time”, both traces start at the exact same time.  
 

 
 
● Statistical data: this menu item opens a new tab in HW4 View Data that displays the number of data 
points, minimum, maximum, average and standard deviation for each parameter that was recorded. A sub-
menu offers the choice of displaying statistical information only for the data currently shown on the graph (for 
example after zooming) or for an entire log file. When the graph consists of more than one log file (overlays), 
all of the data is being used regardless of its origin. 
 
Mean kinetic temperature: this additional data element is given only for temperature and uses the value of 
activation energy entered in HW4 Global Settings – Language / Unit System tab. 
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When high and low alarm values have been programmed for an input, each individual occurrence of an 
alarm condition is reported in a separate block (Alarm 1, Alarm2, etc.). A separate block is also used for 
each recorded parameter, even when alarm conditions occur simultaneously. Contiguous data points which 
are out-of-limits values are reported as one block. Statistical information is provided for each block. 
 

 
 
● Add / Change calculated parameter: this menu item opens the following form: 
 

 
HW4 can add a calculated parameter to a log file 
that does not have any. The parameter is 
calculated for each data record based on the 
relative humidity and temperature values. 
 
HW4 can also replace the existing calculated 
parameter with a different parameter. 
 
Use the form shown on the left to select the 
desired calculated parameter. 
 
NOTE: some parameters such as Enthalpy, 
Mixing Ratio etc. require barometric pressure as 
a calculation input. Be sure to enter the correct 
pressure value in the form. 
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● Graph settings: this menu item opens the HW4 Global Settings form with Graph Settings Tab selected. 
For details, see Settings and Tools, HW4 global settings. 
 
Note: any change made here to the graph settings will affect all graphs, including the on-line graph 
 

22.2.4 Help 
 
● HW4 Help: opens HW4 Help. 
 
● About HW4: displays the version number and ID number of HW4. 

22.3   View Data Toolbar 
 
 
 
 
 
 
 

 

Switch between the views created by selecting 
or magnifying an area of the chart. 

Switch between time windows 

Return to the original view and drop all 
other views 

Draw with the mouse a rectangular area of the graph. The graph 
displays only the selected area 

Magnify an area of the graph, using the magnifier symbol 

Show or hide the Data Cursor to display numerical 
values in the graph 

Print 
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22.4   Graph Tab 

22.4.1 Using the Data Cursor 
 
In the toolbar, left click on the Data Cursor button. The Data Cursor appears as a vertical bar on the graph. 
Labels appear next to the data cursor to display numerical values. 
 
 

Bring the mouse cursor over either the left or 
the right border of the chart. The Data 
Cursor moves towards the border with each 
mouse click. 

Bring the mouse cursor over any location in 
the chart. The Data Cursor jumps to that 
location with a mouse click. 
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22.4.2 Displaying hidden data labels 
 
When two traces on the chart are close one to the other, it may happen that the data labels attached to the 
Data Cursor are on top one of the other. Left clicking with the mouse on any visible label makes the label 
move 90° clockwise and can be used to uncover a hidden label.  
 
a) The temperature data label is hidden behind the humidity data label 
 

 
 
b) Left click with the mouse on the humidity data label. The temperature data label becomes visible. 
 

 
 

22.4.3 Selecting which traces are displayed by the graph 
 
Right clicking with the mouse over any area of the graph opens the following menu: 
 
• Insert text box (see Adding text notes directly in the graph, further down) 
• Show all traces: displays all available traces on the graph 
 
To select a trace, bring the mouse cursor over one of the chart traces. The cursor changes to a hand. Right 
click with the mouse to select the trace. The color of the trace changes and the following menu opens: 
 
• Hide this trace 
• Show this trace only 
• Show alarm band: shows on the graph the alarm settings (if any) for the selected trace. The alarm band 

can be displayed only for one trace at a time. The alarm band appears as two shaded areas of the same 
color as the trace. To hide, deselect the menu item. 

• Attach text/data box (see further down) 
• Show all traces 
 
Note: showing the alarm band for one of the traces usually results in a different scale. 
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22.4.4 Attaching a text / data box to a trace 
 
Bring the mouse cursor close to a trace. Right click with the mouse when the cursor changes to a hand. 
Doing this selects the trace and also opens a small menu box.  
 
The menu item Attach Text/Data Box creates a text / data box that is attached to a specific location of the 
selected trace. Upon selecting this menu item, the mouse cursor changes to a cross. By default, HW4 fills 
the text box with data corresponding to the location of the mouse cursor. Move the mouse cursor (cross) to 
any location on the trace. The data in the box changes as the box moves along the trace. 
 
To attach the text box, left click with the mouse when the cursor is at the desired location. The mouse cursor 
jumps inside the text box and the text inside the box is highlighted (edit mode). Left click with the mouse to 
edit the contents of the box. Use the keyboard arrow keys to move the cursor to a location where text is to 
be inserted or added. When done, left click with the mouse anywhere in the graph. 
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Bringing the mouse cursor over the text box makes the cursor change into a hand. At that time, right clicking 
with the mouse opens another menu: 
 
• Edit text box: use to add text after the numerical data or to replace the numerical data with text 
• Delete text box 
• Orientation: use one of the available options to place the text box at a convenient location 
 

 

22.4.5 Adding a text note directly in the graph 
To create a text note that is not attached to a specific trace, use the following two steps: 
 
a) Create and position the text box: bring the mouse cursor to the location of the graph where you want to 
add a text note. Right click with the mouse. This opens a small menu. In this menu, select Insert Text Box. 
The mouse cursor changes to a cross and a textbox is created with the text: “Enter text here”. Move the 
cross to the desired location of the text box and left click with the mouse. 
 
b) Enter the text: right click with the mouse on the text box. This opens a small menu. Select Edit Text Box 
and type the text in the blue area. When done, left click with the mouse 

22.4.6 Deleting a text note or text/data box 
Make sure that the Data Cursor is not visible. Bring the mouse cursor over the text/data box. The cursor 
changes to a hand (the hand appears only when the data cursor is not visible). Right click with the mouse. 
This opens a small menu. Select Delete Text Box and left click with the mouse 
 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 136 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

22.5   Data Table / File Name Tab 
Clicking on the file name tab, displays both the contents of the file header (top of the form) and the data in 
the form of a table (bottom of the form). Values that correspond to an alarm condition (if any was specified 
for the probe in Device Manager) are shown over a red background. 
 

 

22.6   Working with log files and graphs (How To) 
Add / Change calculated parameter
Superimpose several log files within a single graph
Merge several log files into a single file
Use a common time origin when displaying log files within a single graph
Display statistical data
View numerical data directly within a graph (Data Cursor and Data Labels)
Display a data label that is hidden behind another label
Attach a text or data box to a trace within a graph
Add a text note to a graph
Delete a text note or a text/data box
Select which trace to display in a graph
Display in a graph the alarm band corresponding to a trace
Make a copy of a file in LOG format, converted to the text format (XLS)
Sign a log file
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23  ALARM INDICATION & REPORTING - Overview 

23.1   Standard alarm notification (all HW4 versions) 
When a device detects an alarm condition, all versions of HW4 give a visual notification on the PC monitor. 
Device alarm conditions are defined when configuring the device with Device Manager. 

23.1.1 Device tree 
Any individual device reporting an alarm condition appears in red in the device tree. Device groups also 
appear in red when a member of the group reports an alarm condition.  
 

 
 

23.1.2 Right Pane - Current Values Tab 
Both in Device View and in Group View, values that are out of limits appear in red. 
 

 
 
Note: limit values for each individual device and input are defined in Device Manager 
 
Other types of alarms are also shown in red on the screen as illustrated below: 
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23.2   Customized alarm notification and reporting (HW4 Professional) 
 
HW4 Professional gives the user a high level of flexibility regarding the processing of alarm conditions, 
Different settings can be defined for different instruments, alarm conditions can be processed differently 
based on the severity level, etc. 
 
For details, see HW4 Global Settings: Alarm Settings Tab
 

23.3   Alarm recording and reporting (HW4 Professional) 
HW4 Professional maintains a file consisting of alarm records with detailed information. Old records are 
automatically transferred to an alarm archive file created by HW4. 

23.3.1 Alarm Table 
Alarm records, both current and past, can be viewed on the PC monitor with the Alarm Table. The alarm 
table can be opened at any time by clicking on Settings and Tools in the HW4 main menu bar and selecting 
View Alarm Table. 
 
Note: alarm conditions that occur simultaneously are reported as separate lines in the alarm table. For 
example, when both the value of temperature and the value of humidity measured by the same probe 
correspond to an alarm condition, the alarm table displays two separate lines, one for temperature and the 
other for humidity.     
 
The alarm table offers a choice of several filters when viewing alarm records. 
 
For details, see Alarm Table

23.3.2 Alarm summary report 
An alarm summary report can be printed by selecting File and Print Summary Report from the Alarm Table 
menu bar. This report reproduces the current contents of the alarm table. The contents of the report depend 
on the selections made as to which information (columns), priority level and dates to display in the Alarm 
Table. 

23.4   Additional alarm data 

23.4.1 Log files 
Measurement data, and other information such as the status of logical inputs, can be recorded on the PC 
and / or locally on a data logger. HW4 offers the possibility of automatically starting a new log file every hour, 
every day, etc.  Within Device Manager, alarm conditions can be defined for any measured or calculated 
parameter or logical input. 
 
A log file (PC or data logger) can be displayed by HW4 in the form of either a chart or a table. In both cases, 
values that correspond to an alarm condition can be made clearly visible on the PC screen:  
 

- When data is viewed as a graph, any alarm band that may be associated with an individual parameter 
can be displayed directly on the graph (limited to one parameter at a time). 

- When data is viewed as table, values that are out of limits appear over a red background (however, the 
red background cannot be printed). 
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Summarized (statistical) data can also be displayed on the PC screen and printed. As illustrated below, each 
individual occurrence of an alarm condition is clearly reported in the statistical data as separate block (one 
parameter and one occurrence per block). 
 

 
 
HW4 offers the possibility of printing log file data either as a graph or as a table. Statistical data can be 
printed separately. 

23.4.2 HygroLog NT / HL-NT Logger event file 
The HygroLog NT maintains a file that records the date, time and description of all logger events, including 
any alarm condition that may have been defined when configuring the logger with Device Manager. This file 
is split between the internal memory of the logger (up to 170 events) and the flash memory card (unlimited 
number of events). All past logger events are available to HW4 as long as the flash memory card is not 
removed from the logger.  
 
HW4 offers the possibility of displaying and printing this file. 
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23.4.3 HygroClip Alarm (legacy) event memory and event viewer 
The HygroClip Alarm (HCA) features an internal memory that can retain up to 680 events. When the 
memory is full, the oldest event is erased whenever a new event is recorded.  The following events are 
automatically recorded by the HCA: 
 
o Logical input alarm 
o End of logical input alarm 
o Relay output alarm 
o End of relay output alarm 
o Device power up 
o Watchdog overflow 
o Configuration written to device 
o Date/Time prior to being changed 
o Date/Time after being changed 
o RS-485 address changed 
o Event memory erased 
 
Accessing the events memory requires the HCA to be connected via RS-485 and a master device to a PC 
with the HW4 software. Using HW4, the Event Viewer is accessed or the event memory is cleared from the 
HCA device manager. 
 
Event Viewer: the Event Viewer displays the most current events. 
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File: the file item is located on the Event Viewer menu bar: 
 

 
 
Print: prints the current contents of the event viewer to a printer or to a file. 
 
Load previous events: opens a date selection box and allows loading in the viewer events from a previous 
day (this operation can be repeated several times). 
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24  ERES REGULATORY COMPLIANCE (HW4 Professional) 

24.1   Required settings and selections 
The following settings and selections are required in order to comply with FDA / GAMP regulatory 
requirements regarding electronic records, electronic signatures (ERES) and the tracking of software 
problems. 
 
o Main Screen Menu Bar – Users and Passwords: create at least one user with administrative rights. 

 
o HW4 Global Settings – General Tab: Enable system monitoring (tracking of software problems) 

 
o HW4 Global Settings – Events Tab: Enable authentication stamps and enable the monitoring of user 

events. 
 

o HW4 Global Settings – Events Tab: enable protocols (see Record keeping by HW4) 
 

o Device Manager – User Information Form: put a check mark in the box labeled “include in log file” 
 

o Device Manager – Keypad Form: disable the MENU key of the HygroLog NT to prevent unauthorized 
or undocumented operations. 

 
o Log file type: select the file extension LOG for the log files (measurement data) recorded either with 

HW4 on the PC or with the HygroLog NT. For the HygroLog NT, the file type is selected from Device 
Manager – Memory Card. For the files recorded by HW4 to the PC, the selection is done in the Log to 
PC tab on the Main Screen at the time the file name is entered. 

 

24.2   Electronic records 
In compliance with regulatory requirements regarding electronic records, electronic signatures (ERES) and 
the tracking of software problems, HW4 maintains a number of event files and protocols. To effectively 
comply with ERES regulatory requirements, both types of record must be enabled in HW4 Global Settings. 
Details on the event files and protocols are provided in the “Record keeping” section of this manual. 

24.3   Log File Format 
Both HW4 (direct data logging to the PC) and the HygroLog NT offer the choice of two different types of file 
format to record the measured data. Both file types have two main sections: the file header and the 
measurement data. 
 
o Binary Files (LOG): the header section of this type of file can be read with a regular text editor. As 

opposed to this, the data section is in binary format and cannot be read with a text editor or imported into 
a program such as Microsoft Excel. Both the header and data sections are protected against alterations. 
If the file contents are somehow modified, HW4 will display an error message when trying to open the 
file. 
 
For maximum protection of the recorded data and to comply with ERES regulatory requirements, 
use the LOG file type. 

 
o Text Files (XLS): these files are entirely in text format and can be read with a regular text editor. This 

type of file is easily imported into Microsoft Excel. Like all the other files created by HW4, files with the 
XLS extension are saved with the “Read Only” attribute. This attribute provides a protection against 
inadvertent file operations such as file delete, file move and saving the file under the same name and 
location (eventually after altering the file contents). Since it is possible to remove the “Read Only” 
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attribute, this attribute does not provide protection against intentional alterations. HW4 does not detect 
alterations to a file with the XLS extension. 

 
As an additional protection, HW4 keeps track of the date and time when a log file is created or copied to the 
PC. This information is kept in the protected user event file and can be compared with the file creation / file 
modification date and time recorded by Windows. 
 
Note: the HygroLog NT automatically gives each log file a name comprised of the last 4 digits of the logger 
serial number, followed by the input number and a sequential run number. 

25  RECORD KEEPING - Overview (HW4 Professional) 
In compliance with FDA / GAMP regulatory requirements regarding electronic records, electronic signatures 
(ERES) and the tracking of software problems, HW4 maintains the following records when enabled to do so 
in HW4 Global Settings: 

25.1   Event Files 
Both HW4 and the HygroLog NT maintain a number of files to keep track of major events. With the 
exception of the HW4 event file (extension ERR), these files are protected. Altering the contents of these 
files will cause any line that has been modified to appear on a red background when the file is opened with 
HW4. By default event files are located in the folder ROTRONIC_HW4\EVENT (see Location of the HW4 
User Folder). 

25.1.1 HW4 events 
A text file with the extension ERR is generated whenever HW4 encounters a software execution problem. 
The HW4 Event files are not directly useful to the HW4 user. These files are meant to be sent to the 
manufacturer and hold information useful to ROTRONIC for troubleshooting software problems. The file 
name consists of the text ErrorHW4Event followed by the date and time. 
 
Example: ErrorHW4Event2010_5_27_17_41_44.ERR 
 
To enable HW4 to keep track of software problems, place a check mark in the box labeled Enable System 
Monitoring, located in HW4 Global Settings – General tab. 

25.1.2 User events 
A user event file with the extension EVT is created by HW4 as soon as the very first session begins. 
 
The file name consists of the text HW4USER followed by the year. 
 
Example: HW4USER_2010.EVT 
 
To the purpose of limiting the size of individual files, HW4 starts a new user event file at the beginning of 
each calendar year. Data from several years can still be reviewed on the screen and printed using the user 
events form. 
 
To enable HW4 to keep track of user events, place a check mark in the box labeled Enable Monitoring of 
User Events located in HW4 Global Settings – Events tab. 
 
A separate record with date and time is entered in the user event file for each event listed in the table below: 
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User Event File Text Event 

Start HW4 ID# HW4 ID # started 

User logon A legitimate user has logged on correctly 

Log function programmed The log function of input # has been programmed 

Protocol generated Protocol # has been generated 

Authentication stamp Checksum of protocol # 

Configuration written to device New or existing configuration written to device # 

Error during probe adjustment The probe connected to input # could not be adjusted due to an 
error 

Probe adjusted The probe connected to input # was adjusted 

Device adjusted to PC date and time The date and time of device # was adjusted to the PC date and time 

New user created A new user was created 

Old RS address RS-485 address of device # prior to change 

New RS address RS-485 address of device # after the change 

Language file uploaded to device A new or existing internal language file was uploaded to device # 

File deleted from PC File # was deleted from the PC 

File deleted from logger File # was deleted from the logger memory card 

User data / rights changed User data or rights changed 

Exit HW4 Exit HW4 

Device deleted Device # was deleted from the device tree 

User deleted User # was deleted 

Log-to-PC started Data recording to the PC started for input # 

Log-to-PC stopped Data recording to the PC stopped for input # 

Log file path and name Log file path and name 

HW4 Global Settings saved The HW4 Global Settings were either changed or written over 
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User Event File Text Event 

Logger data file saved to PC Logger data file # was saved on the PC 

Logger data file downloaded Data file # was read from the logger 

Logger configuration saved to PC The logger configuration file # was saved to the PC 

Logger configuration downloaded The configuration of logger # has been read 

Logger event file saved to PC Logger event file # has been saved on the PC 

Logger event file downloaded The event file of logger # has been read 

Authentication stamp of language file 
not valid The HW4 language file is not a factory original 

Unauthorized user tried to log on An unauthorized used tried to log on 

User could not log on (password 
error) An invalid password was entered 

User log off The current user logged off 

25.1.3 Logger events 
 
The HygroLog NT maintains an internal event file with the extension EVT. No particular configuration is 
required to enable this feature.  
 
Part of the procedure to ensure conformity to ERES regulatory requirements is to disable the MENU key on 
the HygroLog NT keypad. The MENU key is the only one that can be used to make changes to the logger. 
Therefore, the events recorded by the HygroLog NT are normally the result of an interaction with the HW4 
software. When the MENU key is not disabled, a limited number of events are recorded in the logger event 
file and no entries are made in the logger event file header. The two tables below provide a list of the events 
tracked by the HygroLog NT. 
 
The logger event file is split between the internal memory of the logger (up to 170 events) and the flash 
memory card (practically unlimited number of events). HW4 offers the possibility of downloading, opening 
and printing the entire file contents. All past logger events are available to HW4 as long as the flash memory 
card is not removed from the logger. The serial number of the logger is used as the file name. 
 
Example: 1111111111.EVT 
 
The logger event file consists of a file header and a file body. The file header provides the following 
information: 
 

- Most recent programming of the log function: programming date and time, user and HW4 product ID 
- Most recent device configuration: date and time, user and HW4 product ID 
- Most recent adjustment to the PC date and time: date and time, user and HW4 product ID 

 
An individual record with date and time is entered in the event file body for each event listed in the table 
below: 
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Logger Event File Text Event (interaction with HW4) 

Power up The battery was inserted or the instrument powered down and up after an 
internal problem 

Watchdog overflow Internal instrument error (normally should not occur) 

Writing device configuration New or existing configuration written to logger 

Memory card removed While recording data, the logger could not find the memory card. The data 
was written to the EEPROM and are not yet lost 

Memory card full No free memory space on the memory card 

New memory card inserted 
The memory card was replaced while data was being logged. The data will 
be split between two different memory cards. Possibly, some data has been 
lost. 

Humidity adjusted Humidity adjustment of the probe connected to input # 

Temperature adjusted Temperature adjustment of the probe connected to input # 

Logging started Start recording data from input # 

Logging stopped manually Data recording of input # ended before the programmed stop time 

Logging ended 
automatically Data recording of input # ended at the programmed stop time 

Out-of-limits value detected An out-of-limits value was newly detected on input # 

Battery almost empty Battery voltage dropped below  6.5V 

Battery empty The battery is empty and the logger has powered itself off (keeping power up 
could result in erroneous data or loss of data) 

Beginning accumulator 
charge Starting to charge the rechargeable battery 

Accumulator charge ended Rechargeable battery full 

MFG command Reserved for the factory 

Lost data, memory card not 
ready 

While recording data, the logger could not find the memory card. The data 
could not be written to the EEPROM, and was lost 

HygroClip probe connected 
1 A HygroClip probe was connected to input # 

HygroClip probe 
disconnected 1

A HygroClip probe was removed from input # or the input can no longer 
communicate with the probe 

External power connected The A/C adapter was connected and is being powered 

External power removed or 
faulty The A/C adapter was disconnected, or failed, or is not being powered 

Device time changed / 
adjusted Device date and time prior and after adjustment (up to firmware v1.1d only) 
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Logger Event File Text Event (interaction with HW4) 

Prior device time Device date and time prior to change (firmware v1.2a and up) 

New device time Device date and time after change (firmware v1.2a and up) 

RS-485 address changed The RS-485 address was changed 

EEPROM erased Reserved for the factory 

Docking station 
disconnected 2

The docking station was disconnected or there is no longer any 
communication with it 

Docking station connected 2 A docking station was connected and communication was established 

Logger language file 
downloaded 

A different internal language file was loaded or the same file was loaded 
again 

Log function programmed The log function has been programmed for input # 

Event file deleted Reserved for the factory 
 

1 connection / removal of analog probes is not recorded 
2 only when the docking station has internal electronics 
 

Logger Event File Text Event (triggered from the Keypad) 

Humidity adjusted Humidity adjustment of the probe connected to input # 

Temperature adjusted Temperature adjustment of the probe connected to input # 

Logging started Start recording data from input # 

Logging stopped manually Data recording of input # ended before the programmed stop time 

Prior device time Device date and time prior to change (firmware v1.2a and up) 

New device time Device date and time after change (firmware v1.2a and up) 

Log function programmed The log function has been programmed for input # 

25.2   Alarm Records and Alarm Archive Files 
HW4 Professional maintains a protected binary file consisting of both current and historical alarm records 
(extension AL2). Altering the contents of this file will cause any line that has been modified to appear on a 
red background when the file is opened with HW4. 
 
The name of the alarm records file is HW4Alarm.al2 
 
By default this file is located in the folder ROTRONIC_HW4\EVENT (see Location of the HW4 User 
Folder). 
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HW4 automatically creates alarm archive files to the purpose of limiting the size of the alarm records file. 
Alarm records are moved to an archive based on the record age (a user defined setting). 
 
Alarm archive files use the following naming convention: HW4Alarm_YYYYMMDD.al2 
 
where YYYYMMDD is the time stamp of the first alarm record present in the file 
 
By default alarm archive files are located in the folder ROTRONIC_HW4\EVENT (see Location of the HW4 
User Folder). 
 
Backward compatibility with previous versions of HW4: 
 
When HW4 version 3.0.0 is started for the first time, any text file with the name HW4_Alarm.alr (legacy) that 
is found in the EVT folder is automatically converted to the new binary format (.al2), Alarm records that are 
older than 3 months are moved to an alarm archice file. Old alarm records files cannot be manually 
converted. These files can be opened and viewed in the Alarm tabe in the same way as newer alarm record 
files. 

25.3   Protocols 
Protocols are text files (extension .txt or .doc) that can be generated, opened and printed from within HW4. 
By default, protocols are located in the directory C:\Documents and Settings\your Windows login 
name\Application Data\ROTRONIC_HW4\DOC 
 
Protocols are enabled by placing a check mark either in the box labeled “Enable Protocols” or in the box 
“Display Protocols” both located in HW4 Global Settings – Events tab. When protocols are enabled, 
HW4 automatically creates the following types of file: 
 
o HW4 configuration protocol: a file is created whenever the HW4 Global Settings are changed. 

 
o Instrument configuration protocol: a file is created whenever the Device Manager function of HW4 is 

used to configure a device / instrument 
 

o Log function programming protocol: a file is created whenever the Data Logging function of HW4 is 
used to program a data logger 
 
Note: HW4 does not create a protocol when data is being logged directly to the PC. However, a record is 
entered in the user event file whenever log-to-PC is started or stopped. This record includes the date, 
time, location and name of the log file. 
 

o Probe adjustment protocol: a file is created whenever the Probe Adjustment function of HW4 is used 
to adjust a probe connected to an instrument 

 
In addition to a detailed description of each event, protocol files include the following information: 
 

- Date and time 
- HW4 current user 
- HW4 version and ID number (product key) 

 
To prevent tampering, HW4 Professional adds an authentication stamp at the end of each protocol. To have 
HW4 automatically validate the authentication stamp whenever a protocol file is opened from within HW4, 
place a check mark in the box labeled “Authentication stamp” box located in HW4 Global Settings – 
Events tab. When the tracking of user events is enabled: 
 

- Whether protocols are enabled or not, HW4 enters a record of the event in the user event file. 
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- When protocols are enabled, HW4 enters an additional record in the user event file for cross-reference 
purposes. This record includes the location and name of the corresponding protocol file. Similarly, the 
protocol text file includes a reference to the user event file (location and file name). 

25.3.1 Protocol file names 
 
o HW4 configuration protocols 

 
The file name for this type of protocol consists of the text HW4_Extras, followed by a sequential number 
generated by HW4. Example of an HW4 configuration protocol file name: HW4_Extras_1.txt 

 
o Instrument configuration protocols 

 
The file name for this type of protocol consists of the serial number of the instrument followed by the 
letters CNF and a sequential number generated by HW4. Example of a configuration protocol file name: 
1111111111_CNF_3.txt 

 
o Log function programming protocols 

 
The file name for this type of protocol consists of the serial number of the instrument followed by the 
letters PROG and a sequential number generated by HW4. Example of a log function programming 
protocol file name: 1111111111_PROG_0.txt 

 
o Probe adjustment protocols 

 
The file name for this type of protocol consists of the serial number of the instrument followed by the 
letters ADJ and a sequential number generated by HW4. Example of a probe adjustment protocol file 
name: 1111111111_ADJ_2.txt 
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25.4   Cross referencing protocols and event files 
By cross referencing the date and time of log files - or the date, time and authentication stamp of the event 
files and protocols, it is possible to keep track of events and to identify which user was logged in HW4 at the 
time of the event. Example: cross referencing a probe adjustment protocol with the user event file 
 
a) Open the probe adjustment protocol: 
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The following information is located at the end of the probe adjustment protocol: 
 

- User information 
- HW4 information 
- User event file: path and name 
- Authentication stamp 

 
b) Open the user event file referenced in the probe adjustment protocol: 
 

 
 
Look for the event “Probe adjusted” (in this example, line 10 of the user event file). Since there could be 
several such events, make use of the date and time of the probe adjustment protocol to find the correct 
event. Compare the following information with the information located at the end of the probe adjustment 
protocol: user name, description and group 
 
Lines 10 and 11 of the user event file report that a probe connected to the HygroClip DI S/N 0019236002 
was adjusted and that a protocol was generated. The date and time should match the date and time of the 
probe adjustment protocol. The authentication stamp on line 12 of the user event file should match the 
authentication stamp of the probe adjustment protocol. 

26  FILE PROTECTION 
The data and record keeping files generated by HW4 are of two types: binary files and text files. Binary files 
use the file extension LOG or AL2 while text files use the file extensions: TXT, XLS, EVT and ERR. 
 

26.1   Authentication stamp 
HW4 makes use of one or more authentication stamps to verify that a file has not been altered. With the 
exception of files with the XLS and ERR file extensions all data and record keeping files generated by HW4 
are stamped. HW4 will display an error message when opening a stamped file that has been altered. 
 
o Binary Files (LOG): Both the header and data sections are protected by an authentication stamp 

against alterations. 
o Binary Files (AL2): The file extension AL2 is used for the files holding the HW4 alarm records captured 

by HW4. This type of file can only be read with HW4. 
o Text Files (TXT): The file extension TXT is used for all protocols generated by HW4. These files are 

protected by a single authentication stamp. 
o Text Files (EVT): The file extension EVT is used for all event files (user and device events). Each 

individual file entry is protected by an authentication stamp. 
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26.2   Overview 
 

File extension Usage Protected 

LOG Log files (recommended format) YES 

XLS Log files (alternate format) NO 

ERR Service files used for trouble shooting NO 

TXT Protocols YES 

EVT User and device events YES 

AL2 Alarm records YES 
 

27  RELOCATING THE HW4 USER FOLDER 

27.1   General guidelines 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WARNING: 
 
Prior to relocating the HW4 User Folder: 
 

o Be sure to have a record of your HW4 ID Number. When HW4 is running, this information can 
be found by clicking on Help – About ROTRONIC HW4 in the HW4 main menu bar. Relocating 
the HW4 User Folder will require re-entering your HW4 ID Number. 
 

o Be sure to copy the HW4 User Folder to the new location. If you do not copy the HW4 User 
Folder to the new location, you will have to re-enter all HW4 users, the HW4 Global Settings and 
you will also have to make a new search for the devices connected to the PC. 

During the initial startup, HW4 automatically creates by default a user folder named ROTRONIC_HW4 
(see Location of the HW4 User Folder). 
 
HW4 also creates the folders DATA, DATA_ONLINE, SYS, DOC and EVENT within the ROTONIC_HW4 
folder. 
 
The ROTRONIC_HW4 folder holds the HW4 configuration data. The subfolders DATA, DATA_ONLINE, 
SYS, DOC and EVENT hold the log files (measurement data), protocols, event files and alarm records. 
 
If for any reason the default path of the HW4 user folder is not suitable, HW4 can be configured to use a 
different path (see example below). 
 
Example: in order to share the contents of the ROTRONIC_HW4 folder between several workstations, the 
folder can be located on a Windows 2003 server. The server drive where ROTRONIC_HW4 is located 
should be mapped to all workstations that will use HW4 and sufficient permissions to the ROTRONIC_HW4 
folder and subfolders must be given by the server administrator to the different workstation users. 
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IMPORTANT: 
 
o Do not change the name of the HW4 user folder. This name must always be ROTRONIC_HW4. 
o You can change freely the name of any of the ROTRONIC_HW4 subfolders 
o The ROTRONIC_HW4 subfolders can be freely relocated and do not have to be within the 

ROTRONIC_HW4 folder 
 

27.2   Preserving and relocating your previous settings and other data 
 
Default file location after the initial HW4 startup: 
 

 
 
• Step 1 

 
Close HW4. Open My Computer. Select C: > Documents and Settings > Windows User > Application 
Data. Open the Application Data folder. 
 
Windows User is the Windows user account that was logged in at the time HW4 was first started. 
 
Select the folder named ROTRONIC_HW4. Assuming that the desired location for the HW4 User Folder 
is C:\ HW4_DATA, copy ROTRONIC_HW4 from its current location to to C:\ HW4_DATA.  
Do not rename the folder. 
 
Note: you may have to change the Windows permissions to the folder and subfolder (Security Tab in 
folder properties). 

 
• Step 2 

 
Start HW4. In the HW4 main menu bar select Settings and Tools > HW4 Global Settings > File locations. 
Point the HW4 User Folder to C:\HW4_DATA: 
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Click on the button to the right of the User Folder Path field. HW4 opens the following box: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Make the selection pointing HW4 to the desired location of the HW4 User Folder (in this example the 
folder HW4_DATA in the root directory of drive C) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click on the OK button. 

 

 
 

Click on the OK button at the bottom right corner of the File Locations tab 
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• Step 3 
 
Close and start HW4 again. 
 
In the HW4 main menu bar select Settings and Tools > HW4 Global Settings > File locations. Change 
the path of the different subfolders used to hold data, configuration, protocol and event files. 

 

 
 

27.3   User Folder relocation using HW4_CurrentDirectory.txt 
 
Note: This method can be used just after installing HW4 and prior to starting HW4 for the first time, or at any 
time thereafter (close HW4 if it is running). 
 
Basic assumption: 
 

- HW4 is already installed on the PC or workstation, in the folder C:\ Program Files\HW4 
 
• Step 1 (skip if HW4 has never been started) 

 
Close HW4. Open My Computer:  
 
► Windows XP: select C:\Documents and Settings\Windows User\Application Data. 
 
► Vista and Windows 7: select C:\Documents and Settings\Windows User\AppData\Roaming. 
 
Windows User is the Windows user account that was logged in at the time HW4 was first started. 
 
Select the folder named ROTRONIC_HW4. 
 
Assuming that the desired location for the HW4 User Folder is C:\ HW4_DATA, copy ROTRONIC_HW4 
from its current location to C:\ HW4_DATA. Do not rename the folder. 
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Note: you may have to change the Windows permissions to the folder and subfolder (Security Tab in 
folder properties). 
 

• Step 2 
 
Open My Computer:  
 
► Windows XP: select C:\Documents and Settings\Windows User\Application Data. 
 
► Vista and Windows 7: select C:\Documents and Settings\Windows User\AppData\Roaming. 
 
Open the folder named ROTRONIC_HW4. Create a new text document and rename this document to 
HW4_CurrentDirectory.txt 
 

• Step 3 
 
Open HW4_CurrentDirectory.txt with Notepad. Create a text line specifying the new path for the HW4 
User Folder (do not put a backslash at the end of the line). 
 
Examples: 

 
 
for C:\Test\ROTRONIC_HW4 
 
 
 
 
 
for C:\ROTRONIC_HW4 
 
 
 

 
 
for J:\ROTRONIC_HW4 (J: is a mapped server drive) 
 
 
 

 
Save and close the file. 
 

 
Note: 
 
If the folder ROTRONIC_HW4 does not exist at the location specified in the text file, it will be automatically 
created upon starting HW4. 
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28  CHANGING THE BAUD RATE OF AN ETHERNET DEVICE 
 
The Baud rate of the internal module of a ROTRONIC device with Ethernet (TCP/IP) interface may have to 
be changed prior to using the device as the master in a RS-485 multi-drop network. 
 
Changing the baud rate of an Ethernet device is a two step process: 
 
(1) Change the baud rate in HW4 > Device Manager > Interface 
(2) Change the baud rate using the Web Interface of the internal Digi International 
      module: Configuration > Serial Port > Basic Serial Settings 
 
The Web Server of the Digi International module can be accessed either directly from Internet Explorer (type 
in the IP address of the module and click on Go) or from the HW4 main menu bar > Settings and Tools > 
Ethernet Configuration Tool (Digi Device Discovery). When Digi Device Discovery is open, right click on the 
device with the mouse and select “Open web interface”. 
 
In the case of a device with a wired connection, no user name or password are required to open the web 
server. By contrast, a device with a wireless connection (WI-ME) requires a user name and password. The 
ROTRONIC factory defaults are as follows: 
 

- User name : rotronic 
- Password    : wlan 

 
Note: if for any reason, you had to reset the WI-ME module to the original Digi International manufacturer 
defaults, the user name reverts to root and the password dbps. 
 
The home page of the Digi module web server is as follows:  
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The left hand side of the web server home page displays a menu. Left click with the mouse on Serial Port to 
gain access to the Serial Port Configuration page: 
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Click with the mouse on Basic Serial Settings. 

 
 
Set the baud rate to match the value entered in Device Manager > Interface. 
 
Warning: exercise caution when using the device web server: 
 
o Be sure to use settings that are compatible with your LAN. 
o The menu item “Serial Port” on the home page allows the configuration of the TCP ports used by the 

device. No configuration should be required. Whatever you do, “Enable raw TCP access using TCP port” 
should always be checked and the port number should always be 2101. 
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29  CONCURRENT HW4 SESSIONS ON DIFFERENT 
WORKSTATIONS 

 
HW4 can be installed on a number of workstations connected to a file server and the HW4 User Folder 
(ROTRONIC_HW4) can be relocated to a file server drive that is mapped to all workstations. The purpose of 
doing this is to be able to use the same data, protocols, events and alarms on all workstations. 
 
IMPORTANT: Installing the HW4 software on the file server is not recommended and may not work. 
 
LIMITATIONS: Running concurrent sessions of HW4, each on a different workstation is subject to the 
following limitations. 
 
o The HW4 user who opens the first session (or Master session) can use HW4 with all the rights given to 

that user by the HW4 administrator. 
 
o When an additional session starts on one of the other workstations, HW4 issues the following warning: 

 

 
 
After clicking on the OK button, HW4 starts the new session. The user of this session has only minimum 
rights (essentially limited to viewing the measurement data), regardless of the rights given to this user by 
the HW4 administrator. This limitation remains in effect until the end of the session, even when the 
original Master session has been ended. 

 
o The new session is not tracked by the HW4 user event file (user login, etc.). 
 
o The Master session is the only one to write to the HW4.ini file (HW4 main screen configuration, etc.). In 

the main, this happens only at the time when this session is closed 
 
o When running concurrent sessions of HW4, the live memory of each workstation holds the information 

that was in the HW4.ini file at the time the workstation opened the HW4 session. No complete update of 
this file takes place during a session. This means that workstations that are running the additional HW4 
sessions are essentially limited to viewing measurement data and that they do not necessarily have 
current information regarding any of the changes made by the Master first session or any activity of that 
session. 

 
o The HW4 edition is automatically the same as the edition used to open the Master session. 
 
o Both the online buffer and online graph are local to each workstation and can be locally cleared without 

affecting the other workstations. 
 
o The only devices that can be seen simultaneously by several workstations are devices connected either 

directly to the LAN (Ethernet) or indirectly connected to the LAN by means of a RS-485 multi-drop. 
Connections via Internet are similar to a LAN connection. To avoid conflicts when devices are being 
polled by several workstations follow the procedure described in this manual under Polling 
Synchronization 
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o Without polling synchronization, conflicts may result when the same device is simultaneously polled by 
several workstations. Using a longer polling interval may make such conflicts less frequent. When there 
is a conflict, a device icon may temporarily appear in the device tree with a red cross over it. This does 
not necessarily mean that communication with the device was lost and it may simply show that the 
device is busy. For example, a HygroLog NT that is in the process of uploading a log file to the server is 
likely to appear busy to a number of workstations. False alarms may be avoided by using an appropriate 
time delay for the alarm type “no communication with device”. 

 
CONFIGURATION: After installing HW4 on the different workstations, each workstation can be configured 
to make HW4 use a common HW4 User Folder (ROTRONIC_HW4) that is located on a drive of the file 
server that is mapped to all workstations. 
 

Relocating the HW4 User FolderSee 
 
It is important to distinguish between a Windows user and a HW4 user. Do not confuse HW4 rights with the 
permissions to a Windows folder. The administrator of the Windows 2003 server should grant sufficient 
permissions to the HW4 user folder and subfolders (Folder Properties – Security tab) so that all workstations 
have access to the same files. 
 
NOTE: The file HW4RunningStatus.dat is located in the HW4 User Folder (ROTRONIC_HW4). This file 
holds the IP address of the workstation that is (or was) running the Master session. This information may be 
used to identify the location of this workstation. 
 
HW4RunningStatus.dat can be opened with Notepad: 
 

 
 
The first line is either a 1 or a 0 (1 means the Master session is still open / 0 means that a new Master 
session can be started). 

29.1   Polling synchronization 
To avoid conflicts when the same device is simultaneously polled by several workstations, proceed as 
follows for each HW4 workstation: 
 
• Step 1: Close HW4. Open My Computer:  

 
► Windows XP: select C:\Documents and Settings\Windows User\Application Data. 
 
► Vista and Windows 7: select C:\Documents and Settings\Windows User\AppData\Roaming. 
 
Windows User is the Windows user account that was logged in at the time HW4 was first started. 
 
Select the folder named ROTRONIC_HW4. 
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• Step 2:  
 
Open the folder named ROTRONIC_HW4. Create a new text document and rename this document to 
HW4_Synch.txt 
 

• Step 3 
 
Open HW4_Synch.txt with Notepad. Create a text line similar to the one shown below: 

 
Comments: 
 
o J: must be a network drive mapped to each HW4 workstation (any mapped network drive may be used). 
o HW4 Synch must be a folder accessible to all HW4 workstation users that log onto the file server domain 

(except for Full Control, give all Windows permissions to each domain user). Any name may be used for 
this folder. 

 
Upon startup HW4 creates two files in the folder declared in HW4_Synch.txt: 
 
HW4_Synch_Close.txt 
HW4_Synch_Open.txt 
 
These files are used by HW4 to synchronize the polling of devices common to the different HW4 
workstations so as to prevent conflicts resulting from the simultaneous polling of the same device by two or 
more workstations. 
 
IMPORTANT: The polling interval (Main Menu Bar > Settings and Tools > HW4 Global Settings > General 
Tab) must be set to a value that allows the different workstations to poll all of the devices present in the 
device tree. For example, if each workstation requires about 6 seconds for polling the devices and there are 
4 workstations, set the polling interval to at least 25 to 30 seconds. 
 

30  MULIPLE HW4 SESSIONS ON THE SAME PC 
We do not recommend running simultaneously multiple sessions of HW4 on the same PC or workstation. 
Doing so may give unpredictable results. 
 
Nevertheless, if you so desire, HW4 will let you open more than one session on a PC or workstation and will 
issue the following warning: 
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31  STARTING HW4 AUTOMATICALLY with Windows 
HW4 can be started automatically by Windows, for example after re-starting the PC. To do this a few steps 
are required. 
 
• Configure Windows so that it can be started without requiring any keystroke or mouse click. 
 
• During the initial start-up HW4 creates the HW4 User Folder following folder in C:\Documents and 

Settings\Windows User\Application Data\ROTRONIC_HW4. Relocate this folder so that it can be 
accessed by all Windows users .See: Relocating the HW4 User Folder 

 
• In the HW4 main menu bar, select Settings and Tools > HW4 Global Settings > General. Use 

the mouse to place a check mark in the box labeled “Auto-Start Mode”. See General Tab  
 
• In Windows, right click on Start and select Explore all Users. 
 
• Select Documents and Settings > All Users > Start Menu > Programs. In Programs, open the folder 

Startup. Right click with the mouse on a blank spot within the folder view and select New > Shortcut. 
 

• This opens the create shortcut wizard: 
 

 
 

• Use the Browse button to locate HW4.exe in C:\Program Files\HW4. 
 
Click on the OK button to save the changes. Because the shortcut is in the Startup folder in All Users, 
HW4 will start automatically each time that Windows starts up. 
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32  BASIC ETHERNET CONCEPTS 

32.1   Compatibility requirements 
In order to use a device / docking station on an LAN, the device (also called a host) must to be configured so 
as to be compatible with the LAN. 
 
● IP address (Network ID and Host ID) 
 
An IP address consists of 4 numbers (1 to 3 digits each) separated with dots. On any network, each IP 
address should be unique.  
 
IP addresses are classified as follows: 
 
Class A: 1.x.x.x to 127.x.x.x 
Class B: 128.0.x.x to 191.255.x.x 
Class C: 192.0.0.x to 223.255.255.x 
 
In the above, x is a number between 0 and 255. 
 
Within an IP address, the network ID is defined depending on the class of the IP address and is indicated 
above in bold. The remainder of the address is the host ID. 
 
Typically a local area network (LAN) uses class C IP addresses. In a class C address, the first 3 numbers 
define the network ID and therefore, the maximum number of devices on the network is limited to 254 (host 
IDs of all zeros or all ones are not allowed). 
 
In order for two devices in a network to communicate together, their IP address must contain the same 
network ID. 
 
● Gateway Address 
 
The gateway address used by the host should be the LAN IP address of the router used to interface with 
other networks (e.g. Internet) or sub-networks. When there is no router, you may try any unused IP address 
on the network. 
 
● Subnet Mask 
 
The subnet mask is used to differentiate the network ID portion of an IP address from the host ID. 
 
Class A: 255.0.0.0 
Class B: 255.255.0.0 
Class C: 255.255.255.0 
 
Note: if more network ID’s are required, the last number of the subnet mask can be used but this reduces 
the maximum number of hosts available for each network ID. 
 
In order for two devices in the same network to communicate together, their subnet mask must be the same. 
 
● TCP port 
 
TCP ports are used to specify how requests are sent to a device and how a device listens to requests. HW4 
makes exclusive use of port 2101 to communicate with devices on the LAN. If using a ROTRONIC Ethernet 
docking station, this port number is already configured and should not be changed. 
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32.2   DHCP 
A TCP device / docking station may be configured to enable DHCP (Dynamic Host Configuration Protocol). 
This makes sense only if a DHCP server such as a router is present on the network.  
 
With DHCP enabled, the DHCP server senses when a new device (or host) is connected to the network and 
automatically assigns / configures the device with the next available IP address. The device is also 
automatically configured with the network subnet mask and gateway address. Using DHCP is simple, 
guarantees compatibility with the network and eliminates the possibility of conflicting IP addresses. 
 
An IP address assigned using DHCP is also known as a dynamic address. As long as DHCP remains 
enabled on the host, the host IP address is subject to change. This is not desirable when using HW4. 
 
Once the dynamic address of the host is known, and communication with the host can be established, we 
recommend to change the host IP address to an unused network address and to disable DHCP on the host. 
In this manner, the new host IP address is a static address, not subject to change.  

32.3   MAC Address 
Each individual Ethernet device is given by its manufacturer a unique MAC address that cannot be changed 
by the user. In a way the MAC address is akin to a social security number.  

33  WATER ACTIVITY MEASUREMENT WITH HW4 

33.1   Water Activity: definition and applications 

33.1.1 Definitions 
The moisture content of a product can be defined as the percentage weight of water in relation to the dry 
weight of the product. 
 
Products in which moisture can be present can be classified in two categories: hygroscopic and non 
hygroscopic. Examples of hygroscopic materials are salts, vegetal fibers, most metal oxides, many 
polymers, etc. Examples of non hygroscopic products are metal powders, glass granules, etc. 
 
Regarding the moisture content of a product, we define static equilibrium as a set of conditions under which 
the product does not exchange any moisture with its environment. Under conditions of static equilibrium, the 
moisture content of a hygroscopic product depends on the nature of the product and also on the two 
following factors: 
 
(a) the partial pressure of water vapor in the immediate environment of the product 
(b) the temperature of the product  
 
If the moisture content of a product is not dependent on both these factors, the product is not hygroscopic. 
 
Hygroscopic products may absorb water in different ways: sorption with formation of a hydrate, binding by 
surface energy, diffusion of water molecules in the material structure, capillary condensation, formation of a 
solution, etc. Depending on the absorption process, water is bound to the product with more or less strength. 
Moisture content can include both an immobilized part (e.g. water of hydration) and an active part. 
 
Water activity Aw (or equilibrium relative humidity %ERH) measures the vapor pressure generated by the 
moisture present in a hygroscopic product. 
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Aw = p / ps and %ERH = 100 x Aw, where: 
 
p  : partial pressure of water vapor at the surface of the product 
ps : saturation pressure, or the partial pressure of water vapor above pure water at the product 
        temperature 
 
Water activity reflects the active part of moisture content or the part which, under normal circumstances, can 
be exchanged between the product and its environment. 
 
Water activity is usually defined under static conditions of equilibrium. Under such conditions, the partial 
pressure of water vapor (p) at the surface of the product is equal to the partial pressure of water vapor in the 
immediate environment of the product. Any exchange of moisture between the product and its environment 
is driven by a difference between these two partial pressures. 
 
Finally, water vapor can also be present in a gas or gas mixture. The relative humidity of a gas is defined as 
%RH = 100 x p/ps, where (p) is the partial pressure of the water vapor present in the gas mixture and (ps) is 
the saturation pressure, or the partial pressure of water vapor above pure water at the temperature of the 
gas. 

33.1.2 Aw and Temperature 
Both water activity (materials) and relative humidity (gases) are referred to the saturation pressure (ps) or 
partial pressure of water vapor above pure water: 
Aw = p / ps 
 
%RH = 100 x p/ps 
 
The saturation pressure (ps) is strongly dependent on temperature. At normal room temperature, (ps) 
increases by about 6.2% for a 1°C increase in temperature. In an open environment that is not saturated 
with water vapor, the partial pressure of water vapor (p) does not change with temperature. In a closed 
environment, (p) changes proportionally to the °K temperature (°K temperature = °C temperature + 273.16). 
At normal room temperature, the change in (p) caused by a small change in the °C temperature is practically 
negligible. Because (p) does not change with temperature while (ps) does, the relative humidity of a gas 
(%RH = 100 x p/ps) is strongly temperature dependent. At 95 %RH and room temperature, an increase of 
1°C results in a relative humidity decrease of about 6 %RH. At 50%RH, the same temperature increase 
causes relative humidity to decrease by about 3 %RH. 
 
The water activity of most hygroscopic products is not as strongly dependent on temperature. At room 
conditions, research data typically shows that water activity varies only by roughly 0.0005 to 0.005 Aw (0.05 
to 0.5 %RH) when temperature changes by 1°C. 
 
This is explained by the fact that the partial pressure (p) at the surface of a hygroscopic product does vary 
with temperature. Above most hygroscopic products, the magnitude of the change in the partial pressure of 
water vapor (p) with temperature is similar (but not exactly equal) to the magnitude of the change of the 
saturation pressure (ps) above pure water. 
 
In summary, a change in temperature causes the partial pressure of water vapor above a hygroscopic 
product to change. At the same time, the partial pressure in the air above the product is practically 
unchanged. It follows that any change in the temperature of a hygroscopic product automatically causes the 
product to exchange moisture with the air (or gas) that surrounds it. Moisture is exchanged until the partial 
water vapor pressure at the surface of the product and in the air is equal. When measuring water activity, it 
is essential to keep temperature as constant as possible. 

33.1.3 Applications 
The active part of moisture content and, therefore, water activity, provide better information than the total 
moisture content regarding the micro-biological, chemical and enzymatic stability of perishable products 
such as foods and seeds. For similar reasons, water activity is equally relevant in the pharmaceutical 
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industry where it provides useful information regarding the cohesion of tablets and pills, or the adherence of 
coatings. Water activity can be directly compared with the relative humidity of the ambient air to prevent 
dimensional changes in a product (paper, photographic film), to prevent hygroscopic powders (powdered 
sugar, salt) from caking or turning into a solid block, etc. 
 
Water activity can be used with some products (mostly synthetic products) as a means of indirectly 
measuring the total moisture content. This requires developing sorption isotherms to this purpose. Sorption 
isotherms are graphs that provide the relationship between water activity and moisture content at constant 
temperature. For most natural products, repeatable sorption isotherms cannot be reliably developed and 
water activity should be regarded as separate from moisture content. 

33.2   Instruments and probes for measuring water activity 
In principle, any ROTRONIC instrument and probe from can be used together with HW4 to measure water 
activity. Probe HC2-AW was designed for measuring the water activity of product samples. Use cable 
AC3001 to connect the probe to a USB port of the HW4 PC. 

33.3   Water activity measurement modes in HW4 
The AwE / AwQuick tab is available only with HW4 Professional with AwQuick. HW4 features two modes for 
measuring water activity and the name of the tab depends on which mode has been selected. 
 
● AwE mode 
 
In this mode HW4 monitors the stability of both temperature and humidity. The measurement is 
automatically ended as soon as both humidity and temperature reach equilibrium. The natural (or static) 
equilibration of most products typically requires from 45 to 60 minutes and can take as long as a couple of 
hours. 
 
● AwQuick mode: 
 
In the AwQuick mode, HW4 uses an algorithm to project the full equilibrium value (water activity) of the 
measured product. The measurement is automatically ended and typically requires about 5 minutes. 
 
HW4 performs the following tasks: 
 

1) The value of the humidity signal is constantly monitored 
2) The stability of the temperature signal is constantly monitored  
3) After an initial period of time (dwell time), HW4 uses the humidity data to project the end value of the 

equilibration process (water activity). The measurement ends automatically as soon as the projected 
Aw value is stable. 

 
With the dwell time set to 4 minutes, measurements typically require about 5 minutes. When temperature 
conditions are stable (both at the product and probe), the measurement obtained with the AwQuick mode is 
generally within ± 0.005 aw of the measurement that would be obtained by waiting for full equilibration (AwE 
mode). 
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33.4   Mode selection and settings 
To select the mode and to enter or modify the settings to be used in each mode, click on the Settings button 
located on the AwE / AwQuick tab. 
 

 
 
Note: the values shown above are the most frequently used. 
 
IMPORTANT: Both the selected mode and its settings apply globally to all instruments and probes. 
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33.5   Using the AwE mode 
1) Select the instrument to be used in the device tree (left pane of the HW4 main screen) 
2) In the right pane of the HW4 main screen, select the AwE / AwQuick tab (the label of this tab 

changes depending on which mode is currently selected) 
3) If necessary, click on the settings button and select the AwE mode in the form. Click on the form OK 

button and verify that the tab label reads AwE Mode 
4) To start the measurement, click on the input corresponding to the desired probe. A check mark 

appears on the corresponding box and the Status column changes to “Running”. If so desired, you 
can click on each of the inputs available with the instrument selected in the device tree. 

 
Note: only those inputs that are selected in the View tab appear in the AwE / AwQuick tab. 
 

 
 
When HW4 detects equilibrium condition, the measurement ends automatically and the background color of 
the line corresponding to the probe turns to green. The status column changes to “End Result”. 
 

 
 
 
All data on the line with the green background remains frozen until the process is ended by clicking on the 
input box with the mouse to remove the check mark. 
 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 171 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

33.6   Using the AwQuick mode 
1) Select the instrument to be used in the device tree (left pane of the HW4 main screen) 
2) In the right pane of the HW4 main screen, select the AwE / AwQuick tab (the label of this tab 

changes depending on which mode is currently selected) 
3) If necessary, click on the settings button and select the AwE mode in the form. Click on the form OK 

button and verify that the tab label reads AwE Mode 
4) To start the measurement, click on the input corresponding to the desired probe. A check mark 

appears on the corresponding box and the Status column changes to “Dwell Phase” and to 
“Running” at the end of the dwell time. If so desired, you can click on each of the inputs available with 
the instrument selected in the device tree. 

 
Note: only those inputs that are selected in the View tab appear in the AwE / AwQuick tab. 
 

 
 
When HW4 generates a stable projection, the measurement ends automatically and the background color of 
the line corresponding to the probe input turns to green. The status column changes to “End Result”. 
 

 
 
The data on the line with the green background remains frozen until the process is ended by clicking on the 
input box with the mouse to remove the check mark. 
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33.7   Water activity measurement report 
 
NOTE: Generate and save Protocols” must be enabled in HW4 Global Settings > Events tab 
 
Click on the “Generate Report” button to generate a measurement report. HW4 automatically saves the 
report in the folder Settings\ROTRONIC_HW4\DOC (located in the HW4 installation folder) as a text file with 
the name AW-Quick followed by an automatically generated number. 
 

 
 
 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 173 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

 
 
 
 
 
 



E-M-HW4v3-Main_10 Rotronic AG 
Bassersdorf, Switzerland 

Document code Unit 

Instruction Manual 

Document Type 

HW4 software v.3 General instructions and functions 
common to all devices 

Document title 
Page 174 of 175 

 

© 2010 Rotronic AG                                                                                                              E-M-HW4v3-Main_10 

Use the report menu bar to sign and / or print the report. 
 

 
 

33.7.1 Signing the report 
 
Select “Sign document” from the file menu to add your HW4 user name and a comment text to the report. 
For authentication purposes you will need to enter your password. 
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A new section is inserted at the bottom of the report: 
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